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1.5 คูมือการใชงานโปรแกรม 
1.5.1 คูมือการใชงานโปรแกรมฐานขอมูลระบบสารสนเทศภูมศิาสตร (GIS) จังหวัดพระนครศรีอยุธยา  

(สําหรับผูบริหารฐานขอมูล GIS) 
ในโลกที่เทคโนโลยีกลายเปนสิ่งที่มีบทบาทอยางมากตอการดํารงชีวิต ยอมปฏิเสธไมไดวาระบบดิจิตอล

นั้นเขามาเอื้อประโยชนในการสนับสนุนการตัดสินใจ ไมเวนแมแตงานดานแผนที่ โดยในปจจุบันนี้ ระบบ
สารสนเทศภูมิศาสตร (Geographic Information System : GIS) เปนเครื่องมือที่มีประสิทธิภาพสูงในการสราง แกไข 
ปรับปรุง รวบรวม สืบคน วิเคราะหและแสดงผล ไดถูกนํามาใชอยางแพรหลาย เพราะมีความสะดวก รวดเร็ว ทั้งยัง
สามารถพัฒนาใหงายตอการใชงานในการวางแผนจัดการขอมูลเชิงพื้นที่ที่ซับซอน เพื่อชวยสนับสนุนในการ
ตัดสินใจที่เกี่ยวของกับพื้นที่ใหเปนไปตามวัตถุประสงคที่ตั้งไว โดยเฉพาะในเรื่องที่เกี่ยวของกับปญหาดาน
ทรัพยากรธรรมชาติและสิ่งแวดลอม   ซึ่งเปนเรื่องที่สามารถชี้วัดถึงคุณภาพชีวิตของมนุษยและ บงบอกถึงสิ่งที่สงผล
กระทบตอมนุษยไดทั้งทางตรงและทางออม ดังนั้นจึงเปนประโยชนอยางยิ่งที่จะนําระบบสารสนเทศภูมิศาสตรมาใช
เพื่อการวางแผนปฏิบัติการฯ ระดับจังหวัดใหเกิดประโยชนสูงสุด 

1) รูจักกับโปรแกรม ArcGIS 
โปรแกรม ArcGIS เปนโปรแกรมระบบสารสนเทศภูมิศาสตร พัฒนาโดย ESRI           

มีสมรรถนะสูงในการแสดงผล วิเคราะหและจัดการขอมูลภูมิศาสตร การทํางานของโปรแกรมออกแบบมาให
สามารถนําไปประยุกตใชงานในดานตางๆ ได มีความสามารถในการจัดการขอมูลขนาดใหญและมีสวนตอประสาน
กราฟกกับผูใช (Graphical User Interface; GUI) สวยงามนาใช 

โปรแกรม ArcGIS 9.2 เปนโปรแกรม Version ลาสุด ทํางานภายใตระบบปฏิบัติการ Windows 
(98/NT2000/XP2002) หรือสูงกวา โดยองคประกอบของ ArcGIS ประกอบดวย ArcView, ArcEditor และ ArcInfo 
การเลือกใชงานซอฟตแวรตัวใดตัวหนึ่งนั้น ขึ้นอยูความตองการของแตละองคกรที่จะเลือกใชงานใหเหมาะสม 
สําหรับ ArcView มีความสามารถเรียกดูขอมูลที่ถูกจัดการภายใต ArcSDE  แต ArcEditer กับ ArcInfo เทานั้นที่
สามารถปรับแกขอมูลภายใต ArcSDE ได ซึ่งเปนซอฟตแวรแบบ Client/Server ที่ใชจัดการฐานขอมูลเชิงพื้นที่ใน
แบบ DBMS (Database Management Systems) โดยองคประกอบทั้งสามของ ArcGIS ที่สรางมาจากเทคโนโลยี
เดียวกันนั้น ประกอบดวย 

ArcView อันไดแก โปรแกรม ArcCatalog, ArcMap และ ArcToolbox ที่มีความสามารถสืบคน 
จัดการ วิเคราะห ปรับแก ขอมูล และสรางแผนที่ได 

ArcEditor มีฟงกชันที่ ArcView มีทั้งหมด และยังมีเครื่องมือที่สามารถปรับแกขอมูลแบบ Coverage 
และ Geodatabase ไดเพิ่มขึ้นมาอีกดวย 

ArcInfo มีฟงกชันที่ ArcEditor มีทั้งหมด พรอมทั้งมีเครื่องมือ Geoprocessing และArcWorkstation 
เสริมมาอีกครบทั้งชุด (ARC, ArcEdit, ArcPlot, INFO, ARC Macro Language หรือเรียกวา AML) 

โดยที่รายละเอียดในแตละสวนมีดังนี้ 

 



การศึกษาพัฒนาระบบสนับสนุนการจัดการ องคการความรวมมือระหวางประเทศแหงญี่ปุน (ไจกา)  
ทรัพยากรธรรมชาติและสิ่งแวดลอม รวมกับ  บริษัท โคคูไซ โคเกียว จํากัด 
ในระดับจังหวัดของประเทศไทย                                                                      และ เอ็กซ คอรปอเรชัน่  
 

 2-28

1.1)  ArcView 
ArcView มีความสามารถในการเรียกดูขอมูล (Data Visualization) สืบคนขอมูล (Query) 

วิเคราะห (Analysis) และสรางแผนที่ (Map Creation) ภายใตระบบปฏิบัติการ Windows โดยมีเครื่องมือสําหรับ
สํารวจดูขอมูล (Exploring), เลือกบริเวณที่สนใจ (Selecting), แสดงผล (Displaying), ปรับแกขอมูล (Editing), 
วิเคราะห (Analyzing), ใหสัญลักษณ (Symbolizing) และจําแนกชั้นขอมูล (Classifying Data) รวมทั้งสามารถสราง 
ปรับแก และจัดการคําอธิบายขอมูล (Metadata) 

โครงสรางของโปรแกรม ArcView ประกอบดวย ArcCatalog, ArcMap และ ArcToolbox 
โดยโปรแกรม ArcView จะสามารถเรียกใชขอมูลจากไฟลโดยตรง หรือเรียกใชขอมูลจากระบบเครือขาย (Network) 
และยังออกแบบเปน Web - Enabled หมายถึง การเรียกดูขอมูลจากเวบไซตได เนื่องจากโปรแกรม ArcView สราง
จากเทคโนโลยีแบบ COM (Component Object Model) จึงสามารถปรับปรุง (Customize) และสามารถเขียน
โปรแกรมแมโคร (Macros) ซึ่งเปนภาษา Visual Basic for Applications (VBA) หรือเขียนโปรแกรมเพิ่มเติม 
(Extensions) จากภาษาตางๆ เชน Visual Basic, C++ และ Delphi ซึ่งความสามารถหลักของ ArcView ไดแก 

- สํารวจดูขอมูล (Explore) แสดงภาพ (Display) และสืบคนขอมูลเชิงพื้นที่  
(Query spatial data) 

- เขาถึงและปรับแกขอมูล Shapefile และ Personal geodatabase 
- วิเคราะหเชิงพื้นที่ดวย Geoprocessing 
- จัดทําแผนที่ดวยเครื่องมือตางๆ และยังมีโปรแกรมวิซารด (Wizards) ชวยเหลือ 
- จัดทํารายงานและกราฟ ทั้งแบบสองมิติและสามมิติ 
- ปรับปรุงระบบพิกัด (Projection) ตามที่ตองการได 
- สรางและจัดการขอมูลแสดงประกอบแผนที่ (Annotation) 
- แสดงแผนที่จากระบบอินเทอรเน็ต 
- นําเขาขอมูล (Import Data) หรือสงออกขอมูล (Export Data) จากไฟลขอมูลหลากหลาย
รูปแบบ 

นอกจากนี้ ยังมีโปรแกรมสวนขยาย (Extensions) เพื่อเพิ่มความสามารถใหกับ ArcView ซึ่ง
ประกอบดวย Spatial Analyst, ArcView 3D Analyst, ArcPress, Geostatistical Analyst และ StreetMap เปนตน 

1.2) ArcEditor 
ArcEditor เปน ArcGIS ขนาดกลาง ซึ่งมีฟงกชันของ ArcView ทั้งหมด โดยถูกออกแบบมา

สําหรับองคกรที่เปน Enterprise GIS ตามชื่อของมัน ซึ่งมีความสามารถในการปรับแกขอมูลใน Enterprise GIS 
ตัวอยางเชน ภายใตระบบซึ่งมี ArcInfo และ ArcSDE ทํางานเปนแกนหลักดวยระบบจัดการฐานขอมูลเชิงสัมพันธ 
(Relational Database Management System; RDBMS) จะมีผูใชบางคนปรับแกขอมูลไดโดยอาศัย ArcEditor และมี
ผูใชบางคนกําลังเรียกดูขอมูล หรือสืบคนขอมูลโดยใช ArcView ทํางานไปพรอมๆ กันได 

ArcEditor ประกอบดวยฟงกชันของ ArcView ทั้งหมด และมีสวนที่เพิ่มขึ้นมา คือ สวนที่
สามารถปรับแกขอมูลแบบ Shapefile, Coverage, Personal geodatabase และ Enterprise geodatabase 
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1.3) ArcInfo 
ArcInfo มีความสามารถสูงสุดใน ArcGIS ซึ่งมีฟงกชันทั้งหมดของ Arcview และ 

ArcEditor รวมทั้งยังมี ArcToolbox ครบสมบูรณ และ ArcInfo Workstation ซึ่งประกอบดัวย (ARC, ArcEdit, 
ArcPlot, AML and all extensions) ซึ่ง ArcInfo เปนโปรแกรมทาง GIS ที่ครบสมบูรณ มีฟงกชันไดแก การสราง
ขอมูล ปรับแก สืบคน การสรางแผนที่ และการวิเคราะหขอมูล 

โปรแกรม ArcInfo สามารถใชงานฟงกชันการวิเคราะหขอมูลไดครบสมบูรณ รวมทั้ง
สามารถประยุกตการทํางานใหเขากับโปรแกรมประยุกตอื่นๆ เนื่องจากโปรแกรม ArcInfo สรางขึ้นมาจาก
เทคโนโลยี COM (Component Object Model) ทําใหสามารถแจกจาย Objects โดยการกําหนดกฎเกณฑ และ
พฤติกรรม ของ Objects ซึ่งความสามารถหลักของ ArcInfo ไดแก 

- มีสวนตอประสานกราฟกกับผูใช (Graphical User Interface; GUI) เปนระบบ Windows 
จึงงายตอการใชงาน 

- เปนสถาปตยกรรมแบบ Client/Server 
- มีเครื่องมือการประมวลผลขอมูลที่มีประสิทธิภาพสูงรองรับกระบวนการทํางานทั้งหมด 
ไดแก การสราง จัดการ สืบคน การซอนทับ การวิเคราะห และแสดงผล 

- สามารถปรับแกฐานขอมูลเดียวกันจากผูใชหลายๆ คนได 
- มีเครื่องมืออื่นๆ ที่มีประสิทธิภาพสูง เชน การแปลงระบบพิกัดโดยอัตโนมัติ (On-the-fly 

projection) การแปลงประเภทขอมูล และการนําเขาหรือสงออกขอมูล 
1.4) ArcMap, ArcCatalog, and ArcToolbox 

ArcGIS ทุกประเภท คือ ArcView, ArcEditor และ ArcInfo จะมีโปรแกรมหลัก 3 สวน แยก
ตามฟงกชันการทํางาน คือ ArcCatalog (จัดการกับขอมูล), ArcMap (จัดการกับแผนที่) และ ArcToolbox (จัดการการ
วิเคราะห) ซึ่งทั้งสามโปรแกรมสามารถเรียกใชงานไดพรอมกัน 

ArcCatalog นําไปใชเลือกที่เก็บขอมูล สรางขอมูล และปรับแกคําอธิบายขอมูล (Metadata) 

ArcMap นําไปใชแสดงผล สืบคน ปรับแกขอมลู และสรางเอกสารแผนที ่

ArcToolbox ใชในการวิเคราะหเชิงพื้นที่ วิเคราะหฐานขอมูล แปลงขอมูล (Convert) และ
นําเขา-สงออกขอมูล (Import and Export) 

1.5) ArcMap 
ArcMap ใชสําหรับแสดงภาพ ปรับแกขอมูลเชิงพื้นที่ สรางแผนที่ กราฟ และรายงาน

ArcMap สามารถเรียกดูขอมูลในแบบที่เรียกวา "สิ่งที่เห็นบนหนาจอ เปนสิ่งเดียวกับที่ปรากฎบนแผนที่" และ
สามารถลาก-วางขอมูลจาก ArcCatalog เขามาได โดยการเปดเอกสารแผนที่จาก ArcMap ไวแลวลากขอมูลจาก 
ArcCatalog ที่เปดอยูมาใสที่บริเวณแสดงภาพของ ArcMap ไดโดยตรง 
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ฐานขอมูล GIS จะแสดงบนแผนที่ในโปรแกรม ArcMap ในแบบที่เรียกวาชั้นขอมูล(Layer) 
ซึ่งในแตละชั้นขอมูลจะสามารถแยกตามประเภทขอมูลแตละประเภทที่จัดเก็บ โดยแสดงบริเวณตารางแสดงขอมูล 
(Table of Content, TOC) ของ ArcMap คาตําแหนงเริ่มตนของ TOC จะอยูดายซายมือแตสามารถเปลี่ยนตําแหนงไป
ไวที่ตําแหนงอื่นๆ ไดตามตองการ 

ลําดับการวางชั้นขอมูลใน TOC จะหมายถึง ลําดับการแสดงขอมูลในสวนแสดงแผนที่ ซึ่งก็
คือลําดับที่อยูบนสุดก็จะแสดงภาพอยูบนสุดดวย ดังนั้นควรนําขอมูลที่เหมาะเปนฉากหลังไวในลําดับลางสุด 
เพื่อที่จะไดไมบดบังสิ่งที่ตองการจะใหปรากฎตามวัตุประสงคที่ตั้งไว 

 

 
 

รูปที่ 2-2 โปรแกรม ArcMap 

 
นอกจากดูแผนที่ที่แสดงอยูแตยังตองการคนหาบริเวณที่สนใจอื่นๆ สามารถทําไดโดยการ

คลิกที่ Feature นั้นๆ ก็สามารถเขาถึงขอมูลที่ตองการ ภายใตฐานขอมูลได ArcMap งายตอการออกแบบแผนที่ที่ใช
ประกอบใน เอกสารและสิ่งพิมพทาง Electronics สําหรับบางขอมูลการนําเสนอในรูปแบบอื่นไดดีกวาแผนที่ เชน 
กราฟ รายงาน ซึ่ง ArcMap ได เตรียมไวหลายทางเลือกเพื่อสรางกราฟและรายงานดวย 
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1.6) ArcCatalog 
ArcCatalog เปนโปรแกรมประยุกตที่ใชติดตอกับฐานขอมูล มีประสิทธิภาพหลักคือมี

ความสามารถเลือกที่เก็บขอมูล (Browse) ดูโครงสรางการจัดเก็บขอมูล (Organize) เผยแพรเอกสารแผนที่หรือขอมูล 
สวนตอประสานกราฟกของ ArcCatalog มีลักษณะคลายกับ Windows Explorer แตตางกันที่สามารถเรียกดูขอมูล 
แผนที่และคําอธิบายขอมูล (Metadata) ได 

การเขาถึงขอมูลในจานบันทึก (Disk) หรือในระบบเครือขายทําโดยคลิกปุม Connect to 
Folder แลวเลือกไปตามเสนทางของขอมูลที่ตองการ ArcCatalog สามารถติดตอกับฐานขอมูลไดหลากหลายรูปแบบ
รวมทั้ง SDE and OLE DB databases 
 

 
 

รูปที่ 2-3 โปรแกรม ArcCatalog 

 

กลุมของชุดขอมูลที่ไดเลือกไวจะเรียกวา แคตาล็อก (Catalog) โดยมี Catalog Tree จะอยู
ดายซายมือ ดานขวามือจะเรียกวา Catalog Contents ดานขวามือของโปรแกรม ArcCatalog จะประกอบดวย 3 สวน 
คือ Content แสดงรายการของขอมูล, Preview แสดงภาพหรือตาราง และแสดง Metadata 
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1.7) ArcToolbox 
ArcToolbox เปนเครื่องมือชวยในการวิเคราะหขอมูล GIS ขั้นสูง เชน การแปลงระบบพิกัด 

หรือแปลงประเภทขอมูลจากชนิดตางๆ ระหวางกัน เชน จาก Shapefile ไปเปน Geodatabase เปนตน ดวยการทํางาน
แบบลากและวาง (Drag and drop) ทําใหสามารถนําเขาขอมูลโดยการคลิกลากชื่อและที่เก็บขอมูลจาก ArcCatalog 
ไปยัง ArcToolbox ได 

 

 
 

รูปที่ 2-4 โปรแกรม ArcToolbox 

 
สามารถสรางเครื่องมือที่ตองการขึ้นมาเองได โดยที่เครื่องมือดังกลาวจะตองอยูในรูปแบบ

ไฟลประเภท .exe หรือ .dll   

ArcToolbox ใน ArcInfo มีเครื่องมือมากกวา 140 ชนิดใหเลือกใชงาน เชน เครื่องมือแปลง
ขอมูลประเภทตางๆ (Conversion Tools), เครื่องมือในการวิเคราะหแผนที่ (Analysis Tools) อาทิ เครื่องมือรวมขอมูล
แผนที่ (Union), ตัดแผนที่ (Clip), แยกแผนที่ (Split), สรางแนวกันชน (Buffer) ฯลฯ  

ArcToolbox ใน ArcInfo จะมีสวนที่เชื่อมโยงกับ ArcInfo Workstation โดยอาศัยOpen 
Development Environment (ODE) ซึ่งทําใหผูใช ArcInfo สามารถใช AML และ DLL ได 
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2)  การจัดการกับขอมูล 
2.1) การสรางและนําเขาขอมูล 

การสรางชั้นขอมูล สามารถทําไดในโปรแกรม ArcCatalog โดยปกติ เมื่อติดตั้งโปรแกรม 
ArcGIS แลวจะอยูที่ Start/All Progams/ArcGIS/ArcCatalog  

 

 
 

รูปที่ 2-5 โปรแกรม ArcCatalog 

 
การเริ่มใชงานโปรแกรมโดยคลิกขวาที่ Directory ที่ตองการเก็บชั้นขอมูล เลือก New เพื่อ

สรางชั้นขอมูลตามรูปแบบที่ตองการ เชน Shapefile, Coverage, Personal Geodatabase เปนตน จากนั้นจะปรากฎ
หนาตางใหใสชื่อชั้นขอมูล, ประเภทขอมูล (สามารถเลือกได เชน Point, Polyline, Polygon เปนตน), แกไขการ
อางอิงเชิงพื้นที่ (โดยการคลิกปุม Edit) 
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รูปที่ 2-6 การสรางชั้นขอมูล 

 คลิกขวาเลือก Properties เพื่อทําการสราง Field เปน Attribute ของชั้นขอมูล โดยพิมพ
ชื่อ Field ที่ตองการใสภายใตหัวขอ Field Name และเลือกประเภทของขอมูลที่ไดตั้งชื่อ Field แลวตามประเภท
ขอมูลที่ตองการลงใน Data Type (จะเปนลักษณะ Dropdown Menu) 

 
รูปที่ 2-7 การสรางเขตขอมูลใหแกชั้นขอมลู 

หลังจากนั้นจึงนําชั้นขอมูลที่สรางขึ้นไปทําการเพิ่มขอมูลกราฟกดังหัวขอการแกไข
ขอมูลเชิงพื้นที่ และการแกไขขอมูลเชิงบรรยายในโปรแกรม ArcMap ตอไป 
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การนําเขาขอมลู ทําไดโดยการคลิกปุม “Add Data” ซึ่งอยูที่ File >  Add Data  

ซึ่งจะอยูที่แถบเมนูหลัก (Main Menu) 

 
รูปที่ 2-8 แถบเมนูหลัก (Main Menu) 

หรืออีกทีหนึ่งคือ ปุม      Add Data บนแถบบเครื่องมือมาตรฐาน และอีกวิธีคือการ
เปดโปรแกรม ArcCatalog ขึ้นมาแลว ลากขอมูลที่ปรากฎอยูในโปรแกรม ArcCatalog เขามาใสในโปรแกรม 
ArcMap 

 
รูปที่ 2-9 แถบเมนูหลัก (Main Menu) 

2.2) การแกไขปรับปรุงขอมูล 
สามารถทําไดในโปรแกรม ArcMap ซึ่งเปนสวนหนึ่งของโปรแกรม ArcGIS โดยจะแยก

การแกไขขอมูลออกเปน 2 รูปแบบ คือ การแกไขขอมูลเชิงพื้นที่ (Graphic Data Editing) และการแกไขขอมูลเชิง
บรรยาย (Attribute Data Editing) 

2.2.1)  การสรางและแกไขขอมูลเชิงพื้นที่ 
กอนที่จะเริ่มทําการปรับแกขอมูลจําเปนตองเปดใชเครื่องมือ Editor toolbar ใน

โปรแกรม ArcMap เสียกอน ถาหากแถบเครื่องมือ Editor ยังไมไดถูกแสดงอยู ใหคลิกขวา บนพื้นที่ของแถบเมนู
ตางๆ (Menu Bars) หรือ แถบเครื่องมือ (Toolbars) ก็จะปรากฎฟงกชันการทํางานที่ซอนอยู แลวคลิกเลือก Editor  

 
รูปที่ 2-10 การเปด Editor 
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หรือหากเปดใช Standard Tool ก็จะเห็นปุม Editing  บนแถบเครื่องมือ
ดังกลาวจากนั้นจึงคลิกเพื่อเพิ่มแถบเครื่องมือ Editor โดยตําแหนงของแถบเครื่องมือสามารถเลือกจัดวางไดตามแต
ผูใชกําหนด ดวยการลากไปไวในตําแหนงที่เหมาะสม 

และตองเลือกการทํางาน (Task) วาจะเริ่มตนทําการแกไขขอมูล (Start Editing), 
บันทึกขอมูลที่ทําการแกไข (Save Editing) หรือหยุดทําการแกขอมูล (Stop Editing) โดยแถบเครื่องมือ (Editor 
toolbar) นั้นมีเครื่องมือมากมายใหเลือกใชงาน  

 
รูปที่ 2-11 แถบเครื่องมือ Editor toolbar 

 

แตในกรณีที่ขอมูลเปนประเภท Coverage จะตองแปลงดวยการคลิกขวาแลว
เลือกExport ในโปรแกรม ArcCatalog ใหเปน Shapefile หรือ Personal Geodatabase เสียกอนจึงจะทําการแกไขได 

การแกไขขอมูลในโปรแกรม ArcMap จะเริ่มเมื่อสั่ง Start editing ซึ่ง Edit session 
จะเปนสวนที่เก็บขอมูลที่ไดแกไขไวให จนเมื่อทําการแกไขเสร็จและสั่งหยุดการแกไขหรือเลือกที่จะบันทึกการ
แกไข จึงจะเปนการแกไขขอมูลจริงลงบนขอมูลตนฉบับ  

สําหรับการปรับแกทั้งหมดที่อยูใน Edit session นั้น จะสามารถเห็นไดบนสวน
แสดงแผนที่ แตจะยังไมมีการบันทึกการเปลี่ยนแปลงลงในขอมูลจริงจนกวาจะบันทึกการแกไขแลว  

ปุมตาง ๆ เชน เมนู รายการ Dropdown ที่อยูบนแถบเครื่องมือ Editor เปนสีเทา       
ซึ่งหมายถึงยังไมพรอมใชงาน (Diabled) เพราะวายังไมไดสั่งใหทําการปรับแก จากเมนูในแถบเครื่องมือ Editor 
เลือกรายการ Start Editing 
 

 
 

 

 

 

 

 

 

รูปที่ 2-12 Start Editing 
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การเคลื่อนยายวัตถุ เมื่อทําการ Start Editing แลว ปุมตาง ๆ จะอยูในโหมดพรอม
ใชงาน (Enabled) โดยเครื่องมอืปรับแก (Edit) จะเปนเครื่องมือหลกัสําหรับการเลือกและเคลื่อนยายวัตถุคลิกทีปุ่ม 
Edit  (เครื่องมือนี้อาจถกูเลือกอยู) คลิกลงบนวัตถุ ซึ่งวัตถดุังกลาวจะเปนจุดเดนขึ้นมา (Highlighted)  

 
 
 
 
 
 
 
 
 

รูปที่ 2-13 การเลือ่นวัตถุ 
 

และเมื่อนําเมาสไปวางไวเหนือ วัตถุนั้น รูปของเมาสจะเปลี่ยนเปนสัญลักษณ
ลูกศรสี่ทศิทางนั้นหมายถึงสามารถลากเลื่อนตําแหนงของวัตถุได สังเกตุวาปุมตาง ๆ ที่อยูบนแถบเครื่องมือ Editor 
ขณะนี้จะอยูในโหมดพรอมใชงาน 

 
รูปที่ 2-14 การเลือ่นวัตถุ 

การหมุน (Rotate) วัตถุ สามารถทําไดโดยคลิกที่ปุม Rotate  ก็จะสามารถ
ลากหมุนวัตถุไปรอบๆ จุดยึดของวัตถุที่เลือก (Selection Anchor) นอกจากนี้การเลื่อนจุดยดึ (Anchor) ของวัตถุ เมื่อ
เลื่อนไปแลวก็จะมีผลกระทบตอการหมุนวัตถุดวย 

 
รูปที่ 2-15 การหมุนวัตถุ 
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การกําหนดมุมของการหมุน สามารถเลือกกําหนดคามุมองศาได คามุมที่กําหนดนี้
จะทําใหวัตถุหมุนตามตองการที่ระบุไว ถาใหคามุมองศาเปนคาบวกวัตถุจะหมุนตามเข็มนาฬิกา ถาหากมุมใหเปนคา
ลบวัตถุจะหมุนทวนเข็มนาฬิกา  
 

เครื่องมือ Sketch  เปนเครื่องมือที่สามารถสรางเสนโครง (Sketch) โดย 
sketch เปนกลุมของตําแหนงของจุดทั้งหมดของวัตถุหน่ึงๆ ที่ประกอบกันเปนวัตถุนั้นๆ (Vertices) และ เสน (Edge) 
หลายๆ เสนที่ประกอบกันเปนวัตถุดังกลาว (Segments) โดยการยายตําแหนงจุดหนึ่งจุดภายในวัตถุ (Vertex) 
เครื่องมือ Edit สามารถใชเพื่อเคลื่อนยายตําแหนง Vertex ได คลิกที่ปุม Edit  และดับเบิ้ลคลิกที่วัตถุที่คุณ
กําลังปรับแกอยู จะพบวา (Sketch) ของวัตถุจะปรากฎออกมา พรอมทั้งแสดง Vertices และ Segments เลื่อนเมาสไป
อยูเหนือ Vertex และคลิกลาก Vertex ไปยังตําแหนงใหม รูปรางของ Sketch จะเปลี่ยนแปลงไป  
 

         
รูปที่ 2-16 การยายตําแหนง Vertex 

 

 
การลบ Vertex การปรับแกวัตถุสามารถใชเมน ู Context ชวยในการปรับแก ซึง่

เมนูนี้จะปรากฎเมื่อคลกิขวาที่ Sketch โดยเลือ่นเมาสไปอยูเหนือ Vertex ดานลางซาย แลวคลิกขวาเพื่อใหเมนู 
Sketch แสดงออกมา แลวคลิกเลอืกเมนู Delete Vertex  

              
รูปที่ 2-17 การลบ Vertex 
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การเพิ่ม Vertex นอกจากการเคลื่อนยายและลบ vertices ก็ยังสามารถเพิ่ม vertices 
ไดเชนกัน เลื่อนเมาสไปอยูเหนือเสนของ Sketch คลิกขวาเพื่อเปดเมนู Context menu และเลือกเมนู Insert Vertex  

 
รูปที่ 2-18 การเพิ่ม Vertex 

 

เครื่องมือ Split  ใชในการแยกเสนจากหนึ่งเสนไปเปนสองเสน เริ่มโดยตอง
เลือกเสนที่ตองการ จากนั้นใชเครื่องมือ Split คลิกลงไปบนตําหนงที่ตองการแยกเสน สําหรับคาตั้งตน (Default) นั้น
จะทําใหคาขอมูลเชิงบรรยาย (Attribute Data) ของเสนตนฉบับ ถูกคัดลอกใหแกเสนใหมที่ถูกแยกออกมา  
 

 
 

รูปที่ 2-19 การ Split 
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การลบวัตถุ เลือกวัตถุทีต่องการลบ หรือเลือกขอมูลที่ตองการลบจากตารางขอมลู 
แลวคลกิปุมลบ (Delete)   ที่เมนูมาตรฐาน (Standard toolbar) หรือคลกิคียบอรด Delete วัตถุที่ตองการจะถูก
ลบหายไป             

   
 
 
 

 
รูปที่ 2-20 การลบวัตถ ุ

 
จะเห็นวา การแกไขขอมลูที่กลาวในขางตนนั้น มีเครื่องมือที่มีประโยชนให

เลือกใชงานไดอยางหลากหลาย สําหรับปรบัแกขอมลู นอกจากนั้นผูใชสามารถใชเครื่องมือบนแถบเครื่องมือ
มาตรฐาน (Standard toolbar) เชน ตัด (Cut) คัดลอก (Copy) และวาง (Paste) วัตถุขามเลเยอร และลบ (Delete) วัตถุ 
รวมทั้งสามารถใช Undo และ Redo ผูใชสามารถใชคําสั่ง Undo เพื่อเรียกคืนการทํางานครั้งหลังสุดได  

 
รูปที่ 2-21 เครื่องมือมาตรฐาน 

 
บันทึกการเปลี่ยนแปลงและออกจากโปรแกรม ArcMap จากเมนู Editor คลกิเลือก 

Stop Editing และคลกิ Yes เมื่อมีหนาตางโตตอบสอบถามวาจะบันทึกการเปลีย่นแปลงหรือไม จากเมนูหลกัเลอืก 
File และคลกิเลอืก Exit คลกิ No เมื่อมีหนาตางโตตอบสอบถามวาจะบันทึกเอกสารหรือไม 
 

 

 

 



การศึกษาพัฒนาระบบสนับสนุนการจัดการ องคการความรวมมือระหวางประเทศแหงญี่ปุน (ไจกา)  
ทรัพยากรธรรมชาติและสิ่งแวดลอม รวมกับ  บริษัท โคคูไซ โคเกียว จํากัด 
ในระดับจังหวัดของประเทศไทย                                                                      และ เอ็กซ คอรปอเรชัน่  
 

 2-41

2.2.2)  การสรางและปรับแกแกไขขอมูลเชิงบรรยาย 
ดวยการเรียกใชงานหนาตางขอมูลเชิงบรรยาย เมื่อผูใชตองการปรับแกขอมูลเชิง

บรรยายจะตองปรับแกที่สวนของการ Editing โดยทําการ Start Editing แลวเรียกดูขอมูลเชิงบรรยาย (Attributes) 
ของสิ่งที่ถูกเลือกอยูโดยการคลิกปุม Attributes ก็จะปรากฎหนาตาง Attributes  

 
รูปที่ 2-22 ปุม Attribute 

 
ซึ่งหนาตางขอมูลเชิงบรรยายมีอยู 2 สวนคือ 1. มุมมองขอมูลอยูดานซายมือเปน

รายการของวัตถุ และ 2. สวนที่อยูดานขวามือ คือรายละเอียดของวัตถุที่ถูกเลือกจากมุมมองขอมูลดานซายมือ 

 

 
รูปที่ 2-23 หนาตาง Attributes 

 
ถาเลือกวัตถุมากกวา 1 ชั้นขอมูลและในแตละชั้นขอมูลน้ัน ประกอบดวยวัตถุที่ถูก

เลือกอยูในรายการมุมมองขอมูล ก็สามารถเขาถึงวัตถุที่สนใจในแตละวัตถุโดยการคลิกเครื่องหมายบวก (+) ซึ่งเปน
สัญลักษณเพื่อขยายขอบเขตของรายการ  

ผูใชสามารถแกไขขอมูลเชิงบรรยายที่ตองการ โดยการคลกิที่ชื่อเขตขอมลู (Field) 
นั้นๆ ที่ปรากฎภายในรายละเอียดขอมลูดานขวามือ แลวแกไขคาในสวน Value คาในเขตขอมูลดังกลาว จะถกูแกไข
เปนคาใหม 
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รูปที่ 2-24 การแกไขขอมลูในหนาตาง Attributes 

ถาคุณตองการเปลี่ยนคาของวัตถทุั้งหมดที่ถกูเลือกอยูสามารถทาํไดโดย คลกิที่ชื่อ
ของชั้นขอมูลและพิมพคาตรงที่เขตขอมลู ที่คุณตองการแกไขเปนคาเดียวกันหมด ดานลางคาของเขตขอมูล ทั้งหมด
ที่ถูกเลือกอยูจะเปลี่ยนไปเปนคาที่กําหนดใหใหม 
 

 
รูปที่ 2-25 การแกไขคาในชั้นขอมูล 
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คาในเขตขอมูล PERIMETER ทั้งหมดของชั้นขอมูล WELL_POINT จะเปลี่ยนคา
เปน 15 ทั้งหมด 

ผูใชสามารถใหการคัดลอก (copy) หรือ ตัด (cut) ในแตละคาของขอมูลเชิง
บรรยายหรือคาทั้งหมดของขอมูลเชิงบรรยาย และในการคัดลอกหรือตัด สามารถวาง (pasted) เปนในวัตถุใดวัตถุ
หนึ่งหรือวัตถุทั้งหมดที่ถูกเลือกอยูก็ได 

นอกจากนี้ ยังสามารถใชการคํานวณคาในโปรแกรม ArcMap ที่ผูใชสามารถ
ปรับแกคาขอมูลเชิงบรรยายของวัตถุ โดยการสรางการคํานวณอยางงายๆ หรือกําหนดเงื่อนไขใน Field Calculator 
ซึ่งการทํางานกับ Field Calculator จะทํางานอยูบนวัตถุที่เลือกอยู หรือหากไมมีวัตถุใดเลือกอยูก็จะทํางานกับทุกๆ 
วัตถุ  

การเรียกใชงาน Field Calculator อันดับแรกตองเริ่มที่ Editing session จากนั้นเปด
ตารางของชั้นขอมูลนั้นๆ โดยการคลิกขวาที่ชื่อของชั้นขอมูลตรงบริเวณ Table of Contents แลวเลือกเปดตาราง 
(Open Attribute Table) และเมื่อตาราง Table แสดงออกมาแลวใหคลิกขวาที่หัวเขตขอมูลที่คุณตองการปรับแกจะ
ปรากฎเมนูใหเลือก Calculate Values เพื่อแสดงหนาตาง Field Calculator  

 

 
รูปที่ 2-26 หนาตาง Field Calculator 
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ในการสรางเงื่อนไขใน Field Calculator จะมีเขตขอมูล ฟงกชั่น และโอเปอรเรชั่น
ให   ผูใชไดใชอยางสะดวก คือสามารถคลิกในเขตขอมูล แลวจะปรากฎรายการเขตขอมูลในกลอง Expression เพื่อ
ใชในการสรางเงื่อนไข หรือผูใชสามารถพิมพไดโดยตรง ดังตัวอยางดานลางนี้ จะมีการปรับแกคาเขตขอมูลที่ชื่อวา 
PERIMETER ใหเปนผลของการบวกดวยคาที่กําหนดคือ 10 เขาไปยังทุกๆ คาของเสนรอบวงเดิม (PERIMETER) 

การใชงาน Field Calculator ทําใหผูใชงานงายจากคํานวณขั้นสูง และสามารถ
เลือกปรับแกขอมูลที่เลือกอยู หรือปรับแกทั้งหมดในตาราง   

เมื่อผูใชสรางเงื่อนไขใน Field Calculator แลวและคลิกปุม OK คาในเขตขอมูลก็
จะเปลี่ยนแปลงไปตามเงื่อนไขหรือการคํานวณนั้น   

 

 
รูปที่ 2-27 หนาตาง Field Calculator 
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3)  การพิมพแผนที่ 
ไฟลโครงการที่จัดเตรียมไวให ประกอบดวย Layout หรือ รูปแบบในการพิมพแผนที่ เพียงแคเลื่อน

แผนที่ไปยังตําแหนงที่ตองการ กําหนดมาตราสวน แกไขขอมูลหัวเรื่องและอื่นๆ ตามที่ตองการแลวสามารถสั่งพิมพ
แผนที่ไดทันที  

 
รูปที่ 2-28 Mode Layout View 

แตจะตองเปลี่ยนการแสดงผลไปเปน Mode Layout View เสียกอน เพราะปกติเราจะทํางานอยูใน
สวนของ Map Display โดยคลิกปุม Layout View ดานซายลางของหนาตาง หรือเลือก View > Layout View บน 
Main Menu 

 

 

 

 

 

 

 

รูปที่ 2-29 การแสดงผล Layout View 

 



การศึกษาพัฒนาระบบสนับสนุนการจัดการ องคการความรวมมือระหวางประเทศแหงญี่ปุน (ไจกา)  
ทรัพยากรธรรมชาติและสิ่งแวดลอม รวมกับ  บริษัท โคคูไซ โคเกียว จํากัด 
ในระดับจังหวัดของประเทศไทย                                                                      และ เอ็กซ คอรปอเรชัน่  
 

 2-46

ในการสราง Layout ใหแผนที่ จําเปนตองกําหนดขนาดของแผนที่และคุณสมบัติการพิมพเสียกอน
เนื่องจาก Program ArcGIS จะเปลี่ยนแปลง Layout ตามขนาดกระดาษที่กําหนดไว โดยจะ Default ไวที่ ขนาด A4 
ถาตองการพิมพแผนที่ที่มีขนาดเล็กหรือใหญกวาควรกําหนดขนาดกระดาษเสียกอน โดยคลิกขวาบริเวณกรอบดาน
นอกของ Layout  

 
รูปที่ 2-30 การตัง้คาการพิมพ 

แตหากตองการปรับแตงรายละเอียดตางๆ ทําไดโดยการดับเบิ้ลคลิกเพื่อแกไของคประกอบของแผน
ที่เดิมที่โปรแกรมไดจัดไวให หรือการเพิ่มองคประกอบ (Element) ใหกับแผนที่ใหมโดยการไปที่ Insert บน Main 
Menu  

3.1)  การเพิ่มทิศ (North Arrow) 
 

 

 

 

 

 

 
รูปที่ 2-31 การเพิ่ม North Arrow 
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3.2)  การเพิ่มมาตราสวน (Scale Bar & Scale Unit) 

 

 

 

 

 

 

 
รูปที่ 2-32 การเพิ่มมาตราสวน 

 

นอกจากจะตองเลือกรูปแบบของแถบมาตราสวนที่ตองการแสดงแลว ผูใชงานยังจะตอง
ระบุหนวยของแผนที่ เมื่อ Insert Scale Bar แลวตองการจะเปลี่ยนแปลงหนวยการวัดดวยการขวาที่ Scale bar เลือก 
Properties จะปรากฏหนาตาง Alternating Scale bar properties เลือก Scale and Unit Tab เพื่อทําการเปลี่ยนแปลง 
Unit ที่ตองการ  

 
รูปที่ 2-33 การเปลี่ยนหนวยวัด 
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3.3)  การเพิ่มสัญลักษณ (Legend) 
จากรูปดานลาง จะปรากฎชื่อช้ันขอมูลใหผูใชเลือกวาตองการจะแสดงสัญลักษณใหแกช้ัน

ขอมูลใดบาง โดยกรอบดานซายมือเปนรายชื่อช้ันขอมูลทั้งหมด ดานขวามือเปนช่ือช้ันขอมูลที่ตองการใสสัญลักษณ 
 

 
รูปที่ 2-34 การเพิ่มสัญลักษณ 

ในการแกไขสัญลักษณตองแปลง Legend ใหเปน Graphic เสียกอนโดยคลิกขวาที่ Legend 
Frame  เลือก Convert To Graphic จากนั้นคลิกขวาเลือก Ungroup  อีกที Legend จะถูกแยกเปน Graphic เดี่ยวๆ 
สามารถแกไขชื่อ ลบทิ้ง เปลี่ยนสี จัดกลุมใหม ไดตามตองการ  

 
3.4)  การเพิ่มชื่อแผนที่ (Title) 

 
รูปที่ 2-35 การเพิ่มช่ือแผนที่ 
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หลังจากเสร็จสิน้การตกแตงแผนที่ Menu File เลือก Print Preview เพื่อตรวจสอบกอนการ
พิมพวาขนาดแผนที่เกินขอบเขตของหนากระดาษหรือไม เลือกปุมPrint  เพื่อทําการพิมพแผนที่ 

 
รูปที่ 2-36 การพิมพแผนที่ 

 
ในกรณีที่ไมมีเครื่องพิมพแผนที่สี หรือเครื่องพิมพที่สามารถพิมพแผนที่ขนาดใหญได

หรือไมตองการพิมพ แตตองการนําไปประกอบรายงานนําเสนอใน Program อื่น เชน Microsoft Word, PowerPoint 
หรือการนําเสนอในรูปแบบ HTML  ตัวโปรแกรม ArcGIS ก็สามารถรองรับการแปลงแผนที่ใหอยูในรูปแบบ File 
Format อื่นๆ ได เชน   

- PDF (Portable Document Format)  เปน Electronic Paper หรือกระดาษ
อิเล็กทรอนิกส ที่สามารถแสดงบน web ไดในรูปเอกสาร ที่มีทั้งขอความและรูปภาพ 

- SVG (Scaleable Vector Graphic) รองรับการนําเสนอ Graphic โดยสามารถยอ – ขยาย 
เลื่อนภาพ โดยไมเสียรายละเอียดโดยการนําเสนอผาน Web Browser รวมกับ Plug-in 
SVG Viewer 

- กลุม file ขอมูลรปูภาพ ไดแก 

 BMP ( Windows Bitmap) 
 JPEG ( Joint Photographic Experts Group )  
 TIFF ( Tag Image File Format ) 
 EMF (Enhanced Windows Metafiles) 
 EPS ( Encapsulated Postscript )  
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3.5)  การสงออกแผนที่ (Export Map) 
โดยการ Export Map ที่ File Menu เลือก Export Map 

 
รูปที่ 2-37 การสงออกแผนที่ 

 

4) โปรแกรมฐานขอมูลระบบสารสนเทศภูมศิาสตรเพื่อการวางแผนจัดการ 
ทรัพยากรธรรมชาติและสิ่งแวดลอม 
ฐานขอมูลระบบสารสนเทศภูมิศาสตรเพื่อการวางแผนจัดการทรัพยากรธรรมชาติและสิ่งแวดลอม 

เปนการพัฒนาโปรแกรมเพื่อใหผูใชสามารถใชงานระบบสารสนเทศภูมิศาสตรงายขึ้นและใหความสะดวกในการ
เขาถึงฐานขอมูล ซึ่งผูใชไมจําเปนตองมีความรูลึกซึ้งก็สามารถที่จะใชงานฐานขอมูลระบบสารสนเทศภูมิศาสตรเพื่อ
การวางแผนจัดการทรัพยากรธรรมชาติและสิ่งแวดลอมนี้ได ดวยสวนตอประสานกราฟกกับผูใช (Graphic User 
Interface: GUI) ที่ออกแบบไว จะชวยลดความซับซอนในการทํางานและลดความสับสนในการเขาถึงขอมูล  

รูปแบบการพัฒนาเปนการพัฒนาโปรแกรมเพิ่มเติมดวยภาษาภาพ (Visual Basic for Applications; 
VBA) บนพื้นฐานของโปรแกรม ArcMap 9.2 ทั้งนี้เพื่อใหเกิดประโยชนในการใชงานเฉพาะดานการวางแผนและ
จัดการทรัพยากรธรรมชาติและสิ่งแวดลอมใหกับจังหวัดพระนครศรีอยุธยา 

การติดตั้งโปรแกรมทําไดโดยการคดัลอก (Copy) โฟลเดอร (Folder) ที่อยูในแผน CD-ROM ลงใน
ไดรฟ (Disk Drive) ที่ตองการ ซึ่งโฟลเดอรดังกลาวก็คอื โฟลเดอร    GisAyutthaya โดยมรีายละเอียดภายใน
โฟลเดอรดังนี้ 
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ตารางที่ 2-21 ตารางอธิบายโฟลเดอรเก็บขอมูล 
 

ชื่อโฟลเดอร คําอธิบาย 

     GisAyutthaya โฟลเดอรของจังหวัดพระนครศรีอยุธยา 

         Configdata     โฟลเดอรเก็บโครงแบบ (Configuration) ของโปรแกรม 

         GisData  โฟลเดอรเก็บขอมูล 

             Coverage  โฟลเดอรเก็บขอมูลประเภท Coverage 

             Satellite โฟลเดอรเก็บขอมูลภาพถายดาวเทียม 

             Topo โฟลเดอรเก็บขอมูลแผนที่ภูมิประเทศ (Topographic Map) 

        GIS_ENV_AY.mxd ไฟลโปรแกรม (ArcMap Document) 
 

 
4.1) การเปดไฟลโครงการ 

หลังจากทําการติดตั้งโปรแกรมเรียบรอยแลว ใหเปดโปรแกรม ArcMap ขึ้นมา ซึ่ง
โดยทั่วไปจะอยูที่ Start/All Progams/ArcGIS/ArcMap  

 

 
รูปที่ 2-38 โปรแกรม ArcMap 

 
โดยมีวิธีการเปดไฟลโปรแกรมอยู 2 วิธี คือ การเปดจากโปรแกรม ArcMap ดวยการเปด

โปรแกรม ArcMap กอน แลวตัวโปรแกรมจะแสดงหนาตางใหเลือกไฟล โดยใหเลือก ไฟลโครงการที่ไดจัดทําไว
แลว (An Existing Map) และเลือกไฟล      GIS_ENV_AY.mxd 
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รูปที่ 2-39 การเปดไฟลโครงการ 

หรือเลือกจากจากเมนู File > Open ที่อยูบนเมนูหลัก (Main Menu) ของโปรแกรม แลวเลือกไฟล           
GIS_ENV_AY.mxd จากโฟลเดอรที่เก็บไฟลไว (Browse for maps) 

 และอีกวิธีหนึ่ง คือการดับเบิล้คลกิ (Double-Click) ที่ไฟล         GIS_ENV_AY.mxd ที่ทํา
การคดัลอกมาไวในเครื่อง  

เมื่อเปดไฟลโครงการแลวก็จะปรากฎหนาตางตอนรับเขาสูโปรแกรม 

 
รูปที่ 2-40 หนาตางตอนรับเขาสูโปรแกรม 
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หลังจากนั้น ใหคลิกปุมเขาสูระบบ  (Login) เพื่อนําเขาสูหนาโปรแกรมฐานขอมูลระบบ
สารสนเทศภูมิศาสตรเพื่อการวางแผนจัดการทรัพยากรและธรรมชาติสิ่งแวดลอมจังหวัดพระนครศรีอยุธยา 
โครงการศึกษาพัฒนาระบบสนับสนุนการจัดการทรัพยากรธรรมชาติและสิ่งแวดลอมในระดับจังหวัด  

 
รูปที่ 2-41 โปรแกรมฐานขอมลูระบบสารสนเทศภูมิศาสตร 

 
 

  ซึ่งตําแหนงของ GUI ตามที่โปรแกรมไดกําหนดใหเปนคาเริ่มตน หากผูใชงานทําการ
ปรับเปลี่ยนหนาตาของโปรแกรมและทําการบันทึกทับไฟลเดิม เมื่อเปดโปรแกรมขึ้นมาใหม ตําแหนงของ GUI 
ตางๆ ก็จะเปลี่ยนไปตามที่ผูใชงานทําการแกไข  

โดยในการใชงานโปรแกรมฐานขอมูลระบบสารสนเทศภูมิศาสตรเพื่อการวางแผนจัดการ
ทรัพยากรธรรมชาติและสิ่งแวดลอมของจังหวัดพระนครศรีอยุธยา สามารถจําแนกสวนตอประสานกราฟฟกกับ
ผูใชงาน (GUI) ตามการใชงาน ไดแก 
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รูปที่ 2-42 สวนตอประสานกราฟฟกกับผูใชงานโปรแกรม 

 

4.2) แถบเมนูหลัก (Main Menu) 
เปนสวนที่ถูกกําหนดใหเปนแถบเมนูที่จะตองถูกแสดงทุกครั้งที่เปดใชโปรแกรม ArcGIS 

ซึ่งเปนคาเริ่มตนที่ถูกกําหนดมากับโปรแกรม ArcGIS และไมสามารถเอาแถบเมนูนี้ออกได  
 

รูปที่ 2-43 แถบเมนูหลัก 
 
โดยในแถบเมนูหลักนี้จะมีคําสั่งที่สําคัญ เชน สวนของ 1. File จะมีคําสั่งเพิ่มขอมูล (Add 

Data), บันทึก (Save), พิมพแผนที่ (Print) เปนตน  สวนของ 2. Edit จะมีคําสั่งในการตัด (Cut) คัดลอก (Copy) วาง 
(Paste) เปนตน  สวนของ 3. View จะมีคําสั่งในการขยาย (Zoom), การเปด-ปดแถบเครื่องมือ (Toolbars) เปนตน  
สวนของ 4. Insert จะมีคําสั่งในการใสองคประกอบแผนที่ตางๆ  สวนของ 5. Selection จะมีการขยายสวนที่เลือก 
(Zoom to Selection), ยกเลิกการเลือกวัตถุ (Clear Selected Features) เปนตน  สวนของ 6. Tools จะมีคําสั่งเครื่องมือ
แกไขขอมูล (Editor), การสราง (Graph), การสรางรายงาน (Report) เปนตน  และสวนของ 7. Window ใชในการ
จัดการหนาตางการทํางาน มีคําสั่ง เชน แวนขยาย (Magnifier) ในการขยายเพื่อดูเฉพาะพื้นที่, เปดหนาตางรายการชั้น
ขอมูล (Table Of Content; TOC) เปนตน 

แถบฟงกช่ันที่พัฒนาขึ้นสําหรับโครงการ แถบเมนูหลัก 
แถบเครื่องมือ 

ฐานขอมูล GIS ในโครงการ 

รายการชั้นขอมูล สวนแสดงแผนที่ 
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4.3) แถบฟงกชั่นที่พัฒนาขึ้นสําหรับโครงการ 
เปนฟงกชันที่ไดพัฒนาขึ้นเฉพาะสําหรับโครงการจัดทําฐานขอมูลระบบสารสนเทศ

ภูมิศาสตรเพื่อการวางแผนจัดการทรัพยากรธรรมชาติและสิ่งแวดลอมจังหวัดพระนครศรีอยุธยาเทานั้น เพื่อใหผูใช
สามารถใชงานไดงายขึ้นและมีความสะดวกในการเขาถึงฐานขอมูล อันจะชวยลดความซับซอนในการทํางานและลด
ความสับสนในการเขาถึงขอมูล ซึ่งประกอบดวย ฟงกชั่น GIS Database ขอมูล (Attribute) กราฟ (Graph) สืบคน
ขอมูล (Query) เชื่อมโยงขอมูล (Link) และ Home Position “ฟงกชันการทํางานที่สรางขึ้นภายในโปรแกรม”  

 
รูปที่ 2-44 แถบฟงกชันที่พัฒนาขึ้นสําหรับโครงการ 

 

4.4) แถบเครื่องมือ (Toolbars) 
เปนกลุมของเครื่องมือ ซึ่งโปรแกรม ArcGIS ไดจัดเตรียมไวใหผูใชงาน เพื่อความ

สะดวกสบายในการทํางานกับขอมูลเชิงพื้นที่ ซึ่งมีเครื่องมือเรียงตามลําดับจากดานบนลงไปดานลาง ไดแก  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 2-45 แถบเครื่องมือ 
 
 

 

ระบุรายละเอยีด 

 

ขยายมุมมอง 

ขยายแบบตรึงจุด 

 

ขอบเขตกอนหนา 

เลือกวัตถ ุ

ยอมุมมอง 

ยอแบบตรึงจุด 

แสดงขอบเขตทั้งหมด 

ขอบเขตถัดไป 

เลือกองคประกอบ 

คนหา 

เชื่อมโยงขอมูล 

เลื่อนมุมมอง 

เลื่อน/ขยายแบบตอเนือ่ง 

ยกเลิกการเลือกวัตถ ุ

ไปยัง  x,y  
วัดขนาด 
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4.5) ฐานขอมูล GIS ในโครงการ (GIS Database) 
เปนรายการฐานขอมูลที่จะปรากฎ เมื่อคลิกปุม GIS Database บนแถบฟงกชั่นที่พัฒนาขึ้น

สําหรับโครงการ ซึ่งมีฐานขอมูลภายในโครงการ 2 ฐานขอมูล ที่ผูใชงานสามารถเลือกดูไดทีละฐานขอมูล ไดแก 
ฐานขอมูล PEQMP GIS Database และ ฐานขอมูล DEQP GIS Database ซึ่งสามารถศึกษารายละเอียดเพิ่มเติมไดจาก
หัวขอยอยที่ชื่อ “หนาตางฐานขอมูล (GIS Database)” ที่อยูในหัวขอหลักชื่อ “ฟงกชั่นการทํางานที่สรางขึ้นภายใน
โปรแกรม”  

 
รูปที่ 2-46 ฐานขอมูล GIS ในโครงการ 

 

4.6) รายการชั้นขอมูล (Table of Content: TOC) 
เปนรายชื่อชั้นขอมูลทั้งหมดที่มีอยูในโปรแกรม ซึ่งสามารถเปด/ปดชั้นขอมูลที่ตองการดูได

จากกลอง Check Box ที่อยูดานหนาชื่อชั้นชอมูล นอกจากนี้ยังสามารถคลิกที่เครื่องหมาย + ดานหนาเพื่อใหแสดง
รายละเอียดที่ซอนอยูภายใตชั้นขอมูล หรือคลิกที่เครื่องหมาย - เพื่อใหซอนการแสดงรายละเอียดดังกลาว ใหปรากฎ
เพียงชื่อชั้นขอมูลก็ได 

นอกจากนี้ที่ดานลางซายมือของหนาตาง TOC ยังสามารถเลือกไดวาจะใหแสดงรายการเปน
รูปแบบตามลักษณะของการแสดงแผนที่ (Display) ตามแหลงเก็บขอมูล (Source) หรือตามลําดับการเลือก 
(Selection) ดวยการเลือกแถบภายในหนาตางที่ปรากฎอยูดานลางซายมือของหนาตาง TOC 
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รูปที่ 2-47 รายการชั้นขอมลู 

 

4.7) สวนแสดงแผนที่  
เปนพื้นที่ที่โปรแกรมใชในการแสดงขอมลู ทั้งขอมูลกราฟก (Graphic Data) และขอมลู

รายละเอียด (Attribute Data)  

โดยจะมีปุมคําสั่งทางดานลางซายมือของหนาตางใหเลือกระหวาง Data View ที่ใชในการ
แสดงขอมูล, Layout View ที่ใชในการแสดงรูปแบบในการพิมพแผนที่, ปุมในการปรับสวนแสดงแผนที่ (Refresh) 
และปุมหยุดการวาด (Pause Drawing) 

 
รูปที่ 2-48 สวนแสดงแผนที ่
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5) ฟงกชั่นการทํางานที่สรางขึ้นสําหรับโครงการ  
โปรแกรมจะแบงออกเปน 6 สวนไดแก สวนของหนาตางฐานขอมูล สวนของขอมูล สวนของกราฟ 

สวนของการสืบคนขอมูล สวนของการเชื่อมโยงขอมูล และการตั้งคาแสดงผลเริ่มตน โดยที่สวนตางๆ มีหนาที่ใน
การทํางาน (Function) ตามรายละเอียดของดังนี้  

5.1) หนาตางฐานขอมูล GIS (GIS Database) 
เมื่อคลิกปุมจะแสดงฐานขอมูลภายในโครงการ 2 สวน คือ ฐานขอมูล PEQMP GIS 

Database และ ฐานขอมูล DEQP GIS Database  

จะทําการเปด-ปดชั้นขอมูลที่ปรากฎในหนาตางขอมูลไดดวยการคลิกเพื่อทําเครื่องหมายถูก
ลงในกลองสี่เหลี่ยมหนาชั้นขอมูล (Check Box) 

นอกจากนี้ เมื่อดับเบิ้ลคลิกที่ชั้นขอมูล (Double-click layer) ที่ไดทําเครื่องหมายถูกไวแลว
ภายในหนาตางฐานขอมูล โปรแกรมจะทําการขยายการแสดงผลเขาไปยังขอบเขตของชั้นขอมูลดังกลาว 
 

 
รูปที่ 2-49 หนาตางฐานขอมูล GIS (GIS Database) 
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5.2) ขอมูลอรรถาธิบาย (Attibute Data) 
เปนเครื่องมือที่ใชในการแสดงรายละเอียดของวัตถุทีผู่ใชทําการเลอืก ซึ่งการใชงานจะ

สัมพันธกับหนาตางฐานขอมูล  
เมื่อคลิกปุมขอมูล ทําเครื่องหมายถูกหนาชั้นขอมูลที่ตองการ แลวเลือกวัตถุบนแผนที่ 

โปรแกรมก็จะแสดงรายละเอียดของขอมูลดังกลาวปรากฎขึ้นมา 

ทั้งนี้รูปแบบการแสดงรายละเอียดขอมูล จะแตกตางกันไปตามที่ไดตั้งคาไวใหแกโปรแกรม 
เพื่อความสะดวกรวดเร็วในการเขาถึงขอมูลในแตละชั้นขอมูลตามเปาหมายของโครงการ 

 
รูปที่ 2-50 การแสดงขอมลูอรรถาธิบาย (Attribute Data) 

 โดยจะสามารถสงออกขอมูลที่ไดในรูปแบบของแผนงาน Excel (Microsoft Excel 
Worksheet) ดวยการคลิกปุมสงออกขอมูล  

 
รูปที่ 2-51 ปุมสงออกขอมูล (Export to Excel) 
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  เมื่อคลิกปุมสงออกขอมูลแลวก็จะปรากฎหนาตางสงออก Excel (Export to Excel) 
ขึ้นมา   

 
รูปที่ 2-52 หนาตางสงออก Excel 

 
 ซึ่งกรอบ “ขอมูลทั้งหมด” ดานซายมือจะแสดงชื่อเขตขอมูลทั้งหมดของชั้นขอมูล 

(Fields) ซึ่งสามารถทําเครื่องหมายถูกที่กลองดานหนา (Check Box) แตละเขตขอมูล เพื่อทําการเลือกเขตขอมูลที่
ตองการสงออก และเมื่อทําการเลือกแลว ชื่อเขตขอมูลที่เลือกก็จะไปปรากฎในกรอบดานขวา “ขอมูลที่ตองการ
สงออก”  

 

รูปที่ 2-53 การเลอืกขอมลูเพื่อสงออก Excel 
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หากจะเลือกเขตขอมูลทั้งหมดที่มีเพื่อทําการสงออกขอมูลทั้งหมดของชั้นขอมูล ให
คลิกปุมเลือกทั้งหมด (Select All) หรือหากวาตองการจะยกเลิกรายชื่อเขตขอมูลที่ไดเลือกไว เพื่อทําการเลือกใหม 
ใหคลิกปุมยกเลิกทั้งหมด (Clear Select) 

โดยกรอบ “ขอมูลที่ตองการสงออก” ผูใชสามารถจัดเรียงลําดับกอนหลังใหแกเขต
ขอมูลในการสงออกไดดวยการเลือกชื่อเขตขอมูลที่ตองการเลื่อนตําแหนง แลวคลิกปุมลูกศร เพื่อเลื่อนตําแหนงชื่อ
เขตขอมูลขึ้น หรือลง ตามที่ตองการ  

เมื่อเรียบรอยแลวใหคลิกปุมตกลง เพื่อทําการสงออกขอมูลไปยังโปรแกรม Excel 
ระบบก็จะทําการเปดโปรแกรม Excel ขึ้นมา เพื่อใหทําการบันทึกขอมูลในรูปแบบ Excel ตามที่ตองการตอไป 

 
รูปที่ 2-54 สงออก Excel 

  นอกจากนี้ในการแสดงรายละเอียดขอมูล ยังสามารถแสดงขอมูลเชิงบรรยายดังกลาวในรูปแบบ
ของขอมูลกราฟ โดยการคลิกปุมแสดงกราฟ (Show Graph) ซึ่งจะทําการแสดงผลกราฟขอมูลที่เลือกตามประเภท
กราฟที่โปรแกรมตั้งคาได โดยรายละเอียดการทํางานจะเหมือนกับปุมกราฟ (Graph) ในหัวขอ กราฟ (Graph) ซึ่ง
เปนหัวขอถัดไป 

 
รูปที่ 2-55 ปุมแสดงกราฟ (Show Graph) 
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5.3) กราฟ (Graph) 
ใชในการแสดงผลขอมูลในรูปแบบของกราฟ ซึ่งจะมีลักษณะการใชงานเชนเดียวกันกับปุม

ขอมูล (Attribute) ก็คือ จะแสดงกราฟขอมูลของวัตถุที่ผูใชทําการเลือก โดยการใชงานจะสัมพันธกับหนาตาง
ฐานขอมูล  

เมื่อทําเครื่องหมายถูกหนาชั้นขอมูลที่ตองการ คลิกปุมกราฟ แลวเลือกวัตถุบนแผนที่ 
โปรแกรมก็จะแสดงขอมูลกราฟ ซึ่งประเภทของกราฟที่เลือกใชในแตละชั้นขอมูล จะเปนกราฟแทง กราฟเสน หรือ
กราฟวงกลม โปรแกรมจะแสดงตามคาที่กําหนดใหตามความเหมาะสมในการแสดงผลของ  แตละชั้นขอมูล 

 
รูปที่ 2-56 การแสดงกราฟ (Graph) 

โดยในบางชั้นขอมูลจะตองมีการเลือกคาพารามิเตอรที่ตองการ และเลือกชวงเวลาเก็บขอมูล
วันเริ่มตนและวันสิ้นสุดที่ตองการแสดงขอมูลกราฟ ซึ่งจะตองเลือกจากวันที่กอน ไปถึงวันที่หลังจากนั้นเทานั้น 

 
รูปที่ 2-57 หนาตางเงื่อนไขกราฟ 
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หากชั้นขอมูลใดไมมีการแสดงผลในรูปแบบของกราฟ ก็จะปรากฎกลองขอความขึ้นมาแจง
ใหผูใชงานทราบ  

 
รูปที่ 2-58 กลองขอความ “ไมมีขอมูลกราฟ” 

 

5.4) สืบคนขอมูล (Query) 
 ปุมสืบคนขอมูลน้ี ใชเพื่อการคนหาขอมูลตามอําเภอ หรือทุกอําเภอที่อยูในจังหวัด ซึ่ง
ผูใชงานจะเปนผูกําหนด และเลือกชั้นขอมูลที่ตองการสืบคน จากรายชื่อชั้นขอมูลทั้งหมดที่มีในฐานขอมูล 

 ขั้นตอนคือ คลิกปุมสืบคนขอมูล (Query)  เลือกชื่ออําเภอที่ตองการ หรือเลือกทุกอําเภอ 
และเลือกชั้นขอมูลที่ตองการสืบคนภายในอําเภอที่เลือก แลวคลิกปุมคนหา ก็จะปรากฎรายละเอียดขอมูล 

 นอกจากนี้ผูใชยังสามารถสงออกขอมูลไปเปนรูปแบบ Microsoft Excel ได 
 

 
รูปที่ 2-59 การสบืคนขอมูล (Query) 
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5.5) เชื่อมโยงขอมูล (Link) 
ในชั้นขอมูลผังเมืองรวมจังหวัด แหลงทองเที่ยว ระบบบําบัดน้ําเสีย สถานที่กําจัดขยะ และ

โรงผลิตน้ําประปา จะสามารถใชงานปุมเชื่อมโยงขอมูลได 

ซึ่งเมื่อคลิกปุมเชื่อมโยงขอมูล แลวเลือกวัตถุที่ตองการภายในชั้นขอมูลที่กลาวไวขางตน ก็
จะปรากฎ หนาตางขึ้นมาเพื่อแสดงถึงขอมูลที่โปรแกรมทําการเชื่อมโยงขอมูลไวสําหรับแสดงผล เชน ถาเปนชั้น
ขอมูลผังเมืองรวมจังหวัด ก็จะเชื่อมโยงไปยังโปรแกรม Adobe Acrobat เพื่อเปดไฟลขอมูลผังเมืองรวมจังหวัด ซึ่งอยู
ในรูปแบบ .pdf 
 

 
รูปที่ 2-60 การแสดงผลปุมเชือ่มโยงขอมูล 
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5.6) ตั้งคาการแสดงผลเริ่มตน (Home Position) 
 เปนปุมที่ใชในการปรับปรุงหนาจอ ใหกลับไปแสดงผลแผนที่ตามขอบเขตที่ตั้งคาไวตอน
เริ่มตนโปรแกรม คือแสดงใหเห็นแผนที่ครอบคลุมทั้งจังหวัดพระนครศรีอยุธยา 

 
รูปที่ 2-61 การแสดงผลเริ่มตน 

 นอกจากนี้ยังมีเครื่องมือการทํางานและฟงกชั่นการทํางานอีกมากมาย นอกเหนือจากที่เห็น
อยูในหนาตางของโปรแกรม ซึ่งสามารถเปดดูและเลือกใชไดโดยการคลิกขวา บนพื้นที่ของแถบเมนูตางๆ (Menu 
Bars) หรือ แถบเครื่องมือ (Toolbars) ก็จะปรากฎฟงกชั่นการทํางานที่ซอนอยู 

 
รูปที่ 2-62 เปด-ปดการแสดงเครือ่งมือและฟงกชั่นตางๆ 
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6) คําอธิบายการใชงานแตละชั้นขอมูล  
ชั้นขอมูลจะแบงเปน 3 กลุมหลัก คือ กลุมฐานขอมูล PEQMP GIS Database, กลุมฐานขอมูล DEQP 

GIS Database และกลุมแผนที่พ้ืนฐาน (Base Map)  

 
รูปที่ 2-63 รายชือ่ชั้นขอมูล GIS ทั้งหมดภายในโครงการ 

 โดยรายละเอียดของแตละชั้นขอมูลมดีังตอไปนี้ 
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6.1) ฐานขอมูล GIS เพื่อการจัดทําแผนจัดการทรัพยากรธรรมชาติและสิ่งแวดลอม 
ในระดับจังหวัด  
6.1.1)    สถานีตรวจวัดคุณภาพอากาศของ คพ. (Air Quality PCD) 

เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะ
แสดงหนาตางขอมูลสถานีตรวจวัดคุณภาพอากาศของ คพ. หากคลิกปุมสงออกขอมูล  (Export to Excel) ก็จะปรากฎ
หนาตางดังนี้ 

 
รูปที่ 2-64 รายละเอียดชั้นขอมูลสถานีตรวจวัดคณุภาพอากาศของ คพ. 

 เมื่อคลิกปุมกราฟ (Graph) แลวคลกิเลอืกสถานีที่ตองการดกูราฟ โปรแกรมจะ
แสดงหนาตางกราฟ  

 
รูปที่ 2-65 หนาตางกราฟสถานตีรวจวัดคุณภาพอากาศของ คพ. 
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เพื่อใหผูใชงานเลือกพารามิเตอรที่ตองการ และเลือกชวงเวลาเก็บขอมูลสถานี 
โดยสามารถเลือกวันที่เริ่มตนชวงเวลาเก็บขอมูลที่ตองการ และทําเครื่องหมายถูกที่ Check Box เพื่อเลือกวันที่สิ้นสุด
ของชวงเก็บขอมูลตรวจวัดคุณภาพอากาศของ คพ.  

 
รูปที่ 2-66 การกาํหนดเงื่อนไขกราฟสถานีตรวจวัดคุณภาพอากาศของ คพ. 

จากนั้น คลกิปุมแสดงกราฟ ก็จะปรากฎกราฟ 

 
รูปที่ 2-67 ตัวอยางกราฟสถานีตรวจวัดคุณภาพอากาศของ คพ. 
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6.1.2)    สถานีตรวจวัดคุณภาพน้ําของ JICA (Water Quality Monitoring Stations JICA) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะ

แสดงหนาตางขอมูลสถานีตรวจวัดคุณภาพน้ําของ JICA 

 
รูปที่ 2-68 รายละเอียดชั้นขอมูลสถานีตรวจวัดคณุภาพน้ําของ JICA 

 
 เมื่อคลิกปุมกราฟ (Graph) แลวคลกิเลอืกสถานีที่ตองการดกูราฟ โปรแกรมจะ
แสดงหนาตางกราฟ  

 
รูปที่ 2-69 การกาํหนดเงื่อนไขกราฟสถานีตรวจวัดคุณภาพน้ําของ JICA 
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6.1.3) สถานีตรวจวัดคุณภาพน้ําของ คพ. (Water Quality Monitoring Stations PCD) 
 เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะ

แสดงหนาตางขอมูลสถานีตรวจวัดคุณภาพน้ํา คพ. ซึ่งผูใชงานสามารถเลือกไดวาตองการดูขอมูล (Raw Data) หรือ
ขอมูลสรุป (Summary Data) ไดจากการคลิกแถบเลือกที่อยูทางดานบน 

 
รูปที่ 2-70 รายละเอียดขอมูลสถานีตรวจวัดคุณภาพน้ําของ คพ. 

 

 
รูปที่ 2-71 รายละเอียดขอมูลสรปุสถานีตรวจวัดคุณภาพน้ําของ คพ. 
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เมื่อคลิกปุมกราฟ (Graph) แลวคลิกเลือกสถานีที่ตองการดูกราฟ โปรแกรมจะ
แสดงหนาตางกราฟ  

 
รูปที่ 2-72 หนาตางกราฟสถานตีรวจวัดคุณภาพน้ําของ คพ. 

 

6.2) พื้นที่ตั้งโครงการที่จัดทํารายงาน EIA (EIA Project)  

 เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะแสดง
หนาตางขอมูลโครงการ EIA ที่มีอยูในพื้นที่ 

  
รูปที่ 2-73 ขอมูลคุณภาพน้ําของโครงการทีจ่ัดทาํรายงาน EIA 
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รูปที่ 2-74 ขอมูลคุณภาพอากาศของโครงการที่จดัทํารายงาน EIA 

 

  
รูปที่ 2-75 ขอมูลคุณภาพเสียงของโครงการที่จดัทํารายงาน EIA 
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6.3) สภาพภูมิอากาศ (Weather)  

เมื่อคลิกปุมกราฟ (Graph) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะแสดง
หนาตางใหเลือกขอมูลสภาพภูมิอากาศที่ตองการดูกราฟ โดยสามารถเลือกขอมูลที่จะใหแสดงกราฟไดดังนี้ ปริมาณ 
ไอน้ํา เมฆ ความชื้นในอากาศ ปริมาณน้ําฝน ความเร็วลม แสงอาทิตย และอุณหภูมิ  

 
รูปที่ 2-76 ขอมูลสภาพภูมิอากาศ 

 
เมื่อคลิกปุมกราฟ (Graph) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะแสดง

หนาตางใหเลือกขอมูลสภาพภูมิอากาศที่ตองการดูกราฟ โดยสามารถเลือกขอมูลที่จะใหแสดงกราฟไดดังนี้ กราฟ
เมฆ กราฟไอน้ํา กราฟความชื้นในอากาศ กราฟปริมาณน้ําฝน กราฟความเร็วลม กราฟแสงอาทิตย และกราฟ
อุณหภูมิ  

 
รูปที่ 2-77 หนาตางเลือกแสดงกราฟสภาพภูมิอากาศ 
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โดยเมื่อไดทาํการคลกิปุมเลอืกกราฟที่ตองการแลวก็จะมีหนาตางปรากฎขึ้น เพื่อแสดง
ขอมูลกราฟที่เลอืกไว ดังตัวอยาง 

 
รูปที่ 2-78 หนาตางแสดงกราฟปริมาณไอน้ํา 

 
6.4) โรงงานอุตสาหกรรม (Factories)  

เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกโรงงานอุตสาหกรรมที่ตองการดูขอมูล 
โปรแกรมจะแสดงหนาตางรายละเอียดขอมูลขึ้นมา  

 
รูปที่ 2-79 หนาตางแสดงรายละเอียดขอมลูโรงงานอุตสาหกรรม 
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6.5) สถานพยาบาล (Hospital) 

เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานพยาบาลที่ตองการดูขอมูล โปรแกรมจะ
แสดงหนาตางรายละเอียดขอมูลขึ้นมา  

6.6) สถานที่ทองเที่ยว และแหลงท่ีมีคุณคาทางธรรมชาติและวัฒนธรรม  
(Tourist and Natural and Cultural Heritage Sites) 

คลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานที่ทองเที่ยวที่ตองการดูขอมูล โปรแกรมจะ
แสดงหนาตางรายละเอียดขอมูลขึ้นมา 

เมื่อคลิกปุมเชื่อมโยงขอมูล (Link) แลวคลิกเลือกสถานที่ทองเที่ยวที่ตองการ โปรแกรมจะ
เปดหนาตาง เพื่อแสดงรูปสถานที่ทองเที่ยวนั้น ๆ   

6.7) ผังเมืองรวมจังหวัด (Provincial Development Plan) 
คลิกปุมขอมูล (Attribute) แลวคลิกเลือกผังเมืองที่ตองการดูขอมูล โปรแกรมจะแสดง

หนาตางรายละเอียดขอมูลขึ้นมา 

เมื่อคลิกปุมเชื่อมโยงขอมูล (Link) แลวคลิกเลือกตําแหนงที่ตองการดูผังเมือง โปรแกรมจะ
เปดหนาตางโปรแกรม Adobe Acrobat เพื่อแสดงไฟลขอมูลผังเมือง .pdf 

6.8) ระบบบําบัดน้ําเสีย (Wastewater Treatment Plant) 
คลิกปุมขอมูล (Attribute) แลวคลิกเลือกระบบบําบัดน้ําเสียที่สนใจ โปรแกรมจะแสดง

หนาตางรายละเอียดขอมูลขึ้นมา 

เมื่อคลิกปุมเชื่อมโยงขอมูล (Link) แลวคลิกเลือกตําแหนงระบบบําบัดน้ําเสียที่ตองการ 
โปรแกรมจะเปดหนาตาง เพื่อแสดงรูปถายของระบบบําบัดน้ําเสียดังกลาว 

6.9) สถานที่กําจัดขยะมูลฝอย (Solid Waste Disposal Site) 
คลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานที่กําจัดขยะมูลฝอยที่สนใจ โปรแกรมจะ

แสดงหนาตางรายละเอียดขอมูลขึ้นมา 

เมื่อคลิกปุมเชื่อมโยงขอมูล (Link) แลวคลิกเลือกตําแหนงสถานที่กําจัดขยะมูลฝอยที่
ตองการ โปรแกรมจะเปดหนาตาง แสดงรูปถายของสถานที่กําจัดขยะดังกลาว 

6.10) โรงกรองน้ําประปา (Water Purification Plant) 
คลิกปุมขอมูล (Attribute) แลวคลิกเลือกโรงกรองน้ําประปาที่ตองการดูขอมูล โปรแกรมจะ

แสดงหนาตางรายละเอียดขอมูลขึ้นมา 

เมื่อคลิกปุมเชื่อมโยงขอมูล (Link) แลวคลิกเลือกตําแหนงโรงกรองน้ําประปาที่ตองการ 
โปรแกรมจะเปดหนาตาง เพื่อแสดงรูปโรงกรองน้ําประปาดังกลาว 
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6.11) ระดับน้ําและภาพตัดขวาง (Water Level and Cross Section) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะแสดง

หนาตางขอมูลระดับน้ําและภาพตัดขวาง ซึ่งจะมีอยู 2 สวน ไดแก ระดับน้ํา และภาพตัดขวาง โดยผูใชสามารถเลือก
จากแถบดานบนของกรอบตารางขอมูล 

 
รูปที่ 2-80 ขอมูลระดับน้ํา 

 

 
รูปที่ 2-81 ขอมูลภาพตดัขวาง 
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เมื่อคลิกปุมกราฟ (Graph) แลวคลิกเลือกสถานีที่ตองการดูขอมูล โปรแกรมจะแสดง
หนาตางใหเลือกขอมูลระดับน้ําและภาพตัดขวางที่ตองการ โดยเมื่อไดทําการคลิกปุมภาพตัดขวาง ก็จะมีหนาตาง
ปรากฎขึ้นเพื่อแสดงขอมูลกราฟที่ได 
 

 
รูปที่ 2-82 หนาตางกราฟระดับน้ําและภาพตัดขวาง 

 

 
รูปที่ 2-83 หนาตางแสดงกราฟภาพตดัขวางลาํน้ํา 
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ผูใชงานสามารถเลือกดูขอมูลระดับน้ํา ไดโดยการเลือกชวงเวลาเก็บขอมูลที่ 

ตองการ โดยการใสคาดังตัวอยาง 

 
รูปที่ 2-84 การกาํหนดชวงเวลาเก็บขอมลูระดับน้ํา 

 

 
รูปที่ 2-85 กราฟที่ไดจากการเลือกชวงเวลา 
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6.12) โรงฆาสัตว (Slaughter House) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกโรงฆาสัตวที่ตองการดูขอมูล โปรแกรมจะ

แสดงหนาตางรายละเอียดขอมูล  

6.13) บอดินและบอทราย (Gravel and sand pits) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกตําแหนงบอดินและบอทรายที่ตองการ 

โปรแกรมก็จะแสดงหนาตางรายละเอียดขอมูล   

6.14) การใชประโยชนท่ีดิน ในป 2550 จากภาพถายดาวเทียม Landsat  
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

Landsat 2007 (พ.ศ. 2550) โปรแกรมจะแสดงหนาตางขอมูล  
 

 
รูปที่ 2-86 ขอมูลการใชประโยชนที่ดิน ในป 2550 จากภาพถายดาวเทียม Landsat 

 

เมื่อคลิกปุมกราฟ (Graph) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน ในป 
2550 ซี่งถายโดยดาวเทียม Landsat โปรแกรมจะแสดงกราฟ   
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รูปที่ 2-87 กราฟการใชประโยชนที่ดิน ในป 2550 จากภาพถายดาวเทียม Landsat 

 

6.15) การใชประโยชนท่ีดิน ในป 2548 จากภาพถายดาวเทียม SPOT  
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

SPOT 2005 (พ.ศ. 2548) โปรแกรมจะแสดงหนาตางขอมูล  

 
รูปที่ 2-88 ขอมูลการใชประโยชนที่ดิน ในป 2548 จากภาพถายดาวเทียม SPOT 

 
เมื่อคลิกปุมกราฟ (Graph) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

โปรแกรมจะแสดงกราฟ   
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รูปที่ 2-89 กราฟการใชประโยชนที่ดิน ในป 2548 จากภาพถายดาวเทียม SPOT 

 

6.16) การใชประโยชนท่ีดิน ในป 2541 จากภาพถายดาวเทียม Landsat  
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

Landsat 1998 (พ.ศ. 2541) โปรแกรมจะแสดงหนาตางขอมูล  
 

 
รูปที่ 2-90 ขอมูลการใชประโยชนที่ดิน ในป 2541 จากภาพถายดาวเทียม Landsat 

 

เมื่อคลิกปุมกราฟ (Graph) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 
โปรแกรมจะแสดงกราฟ   
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รูปที่ 2-91 กราฟการใชประโยชนที่ดิน ในป 2541 จากภาพถายดาวเทียม Landsat 

 

6.17) การใชประโยชนท่ีดิน ในป 2531 จากภาพถายดาวเทียม Landsat  
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

Landsat 1988 (พ.ศ. 2531) โปรแกรมจะแสดงหนาตางขอมูล  
 

 
รูปที่ 2-92 ขอมูลการใชประโยชนที่ดิน ในป 2531 จากภาพถายดาวเทียม Landsat 

 
เมื่อคลิกปุมกราฟ (Graph) แลวคลิกไปที่ตําแหนงใดๆ บนแผนที่การใชประโยชนที่ดิน 

โปรแกรมจะแสดงกราฟ   
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รูปที่ 2-93 กราฟการใชประโยชนที่ดิน ในป 2531จากภาพถายดาวเทียม Landsat 

 

6.18) เสนทางน้ํา (Streams and Rivers) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกตําแหนงเสนทางน้ําที่ตองการ โปรแกรมก็จะ

แสดงหนาตางรายละเอียดขอมูล   

6.19) เสนทางคมนาคม (Transportations) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกตําแหนงเสนทางคมนาคมที่ตองการ โปรแกรม

ก็จะแสดงหนาตางรายละเอียดขอมูล   

6.20) ตัวชี้วัดทางเศรษฐกิจ (Economic Index) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกตําแหนงใดๆ ในชั้นขอมูลเศรษฐกิจและสังคม 

โปรแกรมก็จะแสดงหนาตางขอมูลเศรษฐกิจและสังคมของจังหวัด 
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รูปที่ 2-94 ขอมูลเศรษฐกจิและสังคม 

 
เมื่อคลิกปุมกราฟ (Graph) แลวคลิกเลือกตําแหนงใดๆ ก็จะปรากฎกราฟแสดงขอมูล

เศรษฐกิจและสังคม  

 
รูปที่ 2-95 กราฟเศรษฐกิจและสังคม 
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6.21) ประชากร (Population) 
เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกที่ประชากร โปรแกรมก็จะแสดงหนาตาง

รายละเอียดขอมูล  และเมื่อคลิกกราฟ (Graph) แลวคลิกไปที่ตําแหนงบนชั้นขอมูลประชากร โปรแกรมก็จะแสดง
กราฟจํานวนประชากรของจังหวัดพระนครศรีอยุธยา   

 
รูปที่ 2-96 กราฟจํานวนประชากร 

 
6.22) กลุมฐานขอมูล GIS ของ สส. (DEQP GIS Database) 

เมื่อคลิกปุมขอมูล (Attribute) แลวคลิกเลือกตําแหนงที่ตองการในแตละชั้นขอมูลของกลุม
ฐานขอมูล DEQP GIS Database โปรแกรมก็จะแสดงหนาตางรายละเอียดขอมูล ซึ่งจะอธิบายวัตถุที่ผูใชงานไดทํา
การเลือกไว  

 
รูปที่ 2-97 ตัวอยางรายละเอียดขอมูล 
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- ทาเรือ (Ports) 
- ธรณีวิทยา (Geology) 
- สถานที่สําคัญ (Places) 
- สถานศึกษา (Schools) 
- จุดระดับความสูง (Spot Height) 
- ความลาดชัน (Slope) 
- ระดับความสูง (Elevation) 
- ทิศทางความลาดเอียง (Aspect) 
- ชุดดิน (Soil Series) 
- ปาสงวน (Forest Conservation) 
- บอบาดาล (Well) 
- ลุมน้ํา (Basin) 
- ช้ันคุณภาพลุมน้ํา (Watershade) 
- ช้ันน้ําบาดาล (Aquifer) 
- พื้นที่โครงการชลประทาน (Irregation Project Area) 

 
6.23) กลุมแผนที่พื้นฐาน (Base Map) 

เปนกลุมของชั้นขอมูลที่มีไวเพื่อระบุตําแหนงของวัตถุตามขอบเขตการปกครองของพื้นที่ 
โดยแบงออกเปน 4 ระดับ ไดแก 

- หมูบาน (Villages) 
- อําเภอ (Amphoe) 
- ตําบล (Tambon) 
- เทศบาล (Municipalities) 
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ภาคผนวก 
 

ตารางความสัมพันธการใชงานปุมฟงกชั่นโปรแกรมของฐานขอมูล GIS จังหวัดพระนครศรีอยุธยา 

กลุมฐานขอมูลที่พัฒนาขึ้นในโครงการ 
PEQMP GIS Database 

ขอมูล 
Attribute 

กราฟ 
Graph 

เชื่อมโยง 
Link 

1. สถานีตรวจวัดคุณภาพอากาศ คพ. (Air Quality PCD)     

2. 
สถานีตรวจวัดคุณภาพน้ํา JICA  
(Water Quality Monitoring Stations JICA) 

  
  

3. 
สถานีตรวจวัดคุณภาพน้ํา คพ.  
(Water Quality Monitoring Stations PCD) 

  
  

4. โครงการ EIA (EIA Project Area)      

5. สภาพภูมิอากาศ (Weather)     

6. โรงงานอุตสาหกรรม (Factories)      

7. สถานพยาบาล (Hospital)     

8. 
สถานที่ทองเที่ยว และแหลงที่มีคุณคาทางธรรมชาติและวัฒนรรม
(Tourist and Natural and Cultural Heritage Sites) 

 
  

 

9. ผังเมือง (Provincial Development Plan)     

10. ระบบบําบัดน้ําเสีย (Waste Water Treatment Plant)     

11. สถานที่กําจัดขยะ (Disposal Site)    

12. โรงกรองน้ําประปา (Water purification Plant)     

13. ระดับน้ําและภาพตัดขวาง (Water Level and Cross Section)    

14. โรงฆาสัตว (Slaughter House)      

15. ทาเรือ (Ports)     

16. บอดินและบอทราย (Gravel and Sand Pits)      

17. การใชประโยชนที่ดิน ในป 2550 จากภาพถายดาวเทียม Landsat      

18. การใชประโยชนที่ดิน ในป 2548 จากภาพถายดาวเทียม SPOT     

19. การใชประโยชนที่ดิน ในป 2541 จากภาพถายดาวเทียม Landsat      

20. การใชประโยชนที่ดิน ในป 2531 จากภาพถายดาวเทียม Landsat      

21. เสนทางน้ํา (Streams and Rivers)     

22. เสนทางคมนาคม (Transportation)      

23. ประชากร (Population)     

24. ตัวช้ีวัดทางเศรษฐกิจ (Economic index)     
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ตารางความสัมพันธการใชงานปุมฟงกชั่นโปรแกรมของฐานขอมูล GIS จังหวัดพระนครศรีอยุธยา (ตอ) 

กลุมฐานขอมูลของ สส. 
DEQP GIS Database 

ขอมูล 
Attribute 

กราฟ 
Graph 

เชื่อมโยง 
Link 

1. ธรณีวิทยา (Geology)      

2. สถานที่สําคัญ (Places)     

3. สถานศึกษา (Schools)      

4. จุดระดับความสูง (Spot Height)     

5. ความลาดชัน (Slope)      

6. ระดับความสูง (Elevation)     

7. ทิศทางความลาดเอียง (Aspect)      

8. ชุดดิน (Soil Series)     

9. ปาสงวน (Forest Conservation)      

10. บอบาดาล (Well)     

11. ลุมน้ํา (Basin)      

12. ช้ันคุณภาพลุมน้ํา (Watershade)     

13. ช้ันน้ําบาดาล (Aquifer)      

14. พื้นที่โครงการชลประทาน (Irregation Project Area)     

กลุมแผนที่ฐาน 
Base Map 

ขอมูล 
Attribute 

กราฟ 
Graph 

เชื่อมโยง 
Link 

1. หมูบาน (Villages)      

2. อําเภอ (Amphoe)     

3. ตําบล (Tambon)      

4. เทศบาล (Municipalities)      
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1.5.2 คูมือการใชงานโปรแกรม ArcReader จังหวัดพระนครศรีอยุธยา (สําหรับผูใชงานฐานขอมูล GIS) 
ArcReader เปนโปรแกรมที่ใชสําหรับแสดงขอมูลแผนที่ การเรียกดูขอมูลเชิงบรรยาย และพิมพแผนที่ ใน

รูปแบบ Published Map Documents (*.pmf) ซึ่งจัดทําจากโปรแกรม ArcGIS โดยใช ArcPublisher Extension โดย 
ArcReader เปนโปรแกรมที่ไมมีลิขสิทธิ์ สามารถนํามาใชงานไดโดยไมเสียคาใชจาย 

1) การเปดโปรแกรม ArcReader 
คลิก Start ที่ Windows taskbar และไปที่ ArcGIS > ArcReader และคลิกเพื่อเปดโปรแกรม 

 
 

2) สวนประกอบของโปรแกรม ArcReader 
2.1) Menu - เมนู 
2.2) Toolbars - แถบเครื่องมือ 
2.3) Table of Contents - หนาตางรายการขอมูล 
2.4) Data View - หนาตางมุมมองขอมูล 
2.5) Layout View - หนาตางมุมมองแผนที่ 
2.6) Status Bar – แถบสถานะ 

 



การศึกษาพัฒนาระบบสนับสนุนการจัดการ องคการความรวมมือระหวางประเทศแหงญี่ปุน (ไจกา)  
ทรัพยากรธรรมชาติและสิ่งแวดลอม รวมกับ  บริษัท โคคูไซ โคเกียว จํากัด 
ในระดับจังหวัดของประเทศไทย                                                                      และ เอ็กซ คอรปอเรชัน่  
 

 2-90

3) คําสั่งตางๆ ในโปรแกรม ArcReader 
คําสั่งตางๆ ในโปรแกรม ArcReader สามารถเรียกใชไดจากเมนูหรือแถบเครื่องมือ โดย เมนูของ 

ArcReader ประกอบไปดวยเมนูดังนี้ 

 
 

โดยคําสั่งตางๆ ในเมนูที่มีการใชงานบอยสามารถเรียกใชงานไดจากแถบเครื่องมือซึ่งในแตละ
เครื่องมือ เมื่อเอาเมาสไปวางจะมีช่ือของเครื่องมือปรากฏขึ้นมา และมีคําอธิบายปรากฏที่แถบสถานะ สามารถอธิบาย
ลักษณะการทํางานไดดังนี้  

3.1)  เคร่ืองมือท่ัวไป (File Toolbars)  
 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 
Open เปดไฟล Published Map Documents (*.pmf) 
Recent Files เปดไฟลที่เคยเปดใชงานแลว 
Print พิมพแผนที ่
Toggle Table of Contents แสดง/ซอน Table of Contents 

 
Toggle Application 
Into Full Screen Mode สลับหนาจอการแสดงเปนเปนเต็มหนาจอ และหนาจอปกติ 

 
3.2) เคร่ืองมือสําหรับทํางานกับแผนที่ (Navigation Toolbars) 

 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 

 Zoom In ขยายแผนที่ โดยคลิกบริเวณท่ีตองการ หรือกดเมาสคางไว 
แลวลากใหเปนสี่เหลี่ยม 

 Zoom Out ยอแผนที่ โดยคลิกบริเวณท่ีตองการ  หรือกดเมาสคางไว 
แลวลากใหเปนสี่เหลี่ยม 

 Continuous Zoom/Pan ขยาย/ยอแผนที่อยางตอเน่ือง โดยกดเมาสคางไว และเลื่อนลงเพื่อขยาย 
หรือเลื่อนขึ้นเพื่อยอ  

Fixed Zoom In ขยายบริเวณกลางแผนที่ 
Fixed Zoom Out ยอบริเวณกลางแผนที่ 
Pan เลื่อนแผนท่ี โดยกดเมาสคางไว และเลื่อนไปยังทิศทางที่ตองการ 
Full Extent แสดงแผนที่ใหครอบคลุมขอมูลท้ังหมด 
Go Back To Previous Extent กลับไปหนาจอกอนหนาท่ีไดทําการ ยอ/ขาย หรือเลื่อนแผนท่ี 
Go Back To Next Extent กลับไปหนาจอถัดไปท่ีไดทําการ ยอ/ขาย หรือเลื่อนแผนท่ี 
Zoom To Scale  แสดงแผนที่ตามมาตราสวนที่กําหนด 
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3.3)  เคร่ืองมือสําหรับเรียกคนขอมูล (Data Toolbars) 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 

 Identify เรียกดูขอมูลเชิงบรรยายของชั้นขอมูล โดยคลิกที่เครื่องมือ และไปคลิกขอมูลที่ตองการดู
ขอมูลเชิงบรรยาย 

 Find คนหาขอมูล โดยคลิกที่เครื่องมือ เพื่อเขาสูหนาตางFind เพื่อใสเงื่อนไขการคนหา 

 Go To XY ไปยังตําแหนง XY โดยคลิกที่เครื่องมือ เพื่อเขาสูหนาตาง Go To XY เพื่อใสคาพิกัด 

 Measure การวัดระยะ โดยคลิกที่เครื่องมือ เพื่อเขาสูหนาตาง Measure สําหรับการวัดระยะในแผนที ่

 Hyperlinks การเชื่อมโยง โดยคลิกที่เครื่องมือ และคลิกที่ขอมูลที่มีการสราง Hyperlinks ไว 
 

3.4)  เคร่ืองมือสําหรับทํางานกับแผนที่สําหรับการพิมพ (Layout Toolbars) 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 

 Zoom In ขยายแผนที่ใน Layout View โดยคลิกบริเวณที่ตองการ หรือกดเมาสคางไวแลว
ลากใหเปนสี่เหลี่ยม 

 Zoom Out ยอแผนที่ใน Layout View โดยคลิกบริเวณที่ตองการ  หรือกดเมาสคางไวแลว
ลากใหเปนสี่เหลี่ยม 

 Pan เลื่อนแผนที่ใน Layout View โดยกดเมาสคางไว และเลื่อนไปยังทิศทางที่
ตองการ 

 Fixed Zoom In ขยายบริเวณกลางแผนที่ใน Layout View 

 Fixed Zoom Out ยอบริเวณกลางแผนที่ใน Layout View 

 Zoom Whole Page แสดง Layout View ใหครอบคลุมทั้งหมด 

 Zoom To 100% แสดง Layout View ในขนาด 100% 

 
Go Back To 
Previous Extent กลับไปหนาจอกอนหนาที่ไดทําการ ยอ/ขาย หรือเลื่อนแผนที่ใน Layout View 

 
Go Back To 
Next Extent กลับไปหนาจอถัดไปที่ไดทําการ ยอ/ขาย หรือเลื่อน แผนที่ใน Layout View 

 Change Title เปลี่ยนช่ือแผนที่ใน Layout View โดยคลิกที่เครื่องมือและใสช่ือแผนที ่

 Zoom To Percent แสดง Layout View ในขนาดที่กําหนด 
 

3.5)  เคร่ืองมือสําหรับปรับรูปแบบการแสดง (Layer Effects Toolbars) 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 

 Layer List เลือกช้ันขอมูลที่ตองการ 

 Transparency ปรับการโปรงแสงของชั้นขอมูลที่เลือก 

 Swipe Layer การทํางานกับช้ันขอมูลที่ถูกปดบัง 
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3.6)  เคร่ืองมือสําหรับทําเครื่องหมาย (Markup Toolbars) 

 
 

เครื่องมือ ช่ือ ลักษณะการทํางาน 

 Pen วาดเสนกราฟฟกบนแผนที่ 

 Highlighter สรางกราฟฟกบนแผนที่เพื่อเนนขอมูล 

 Eraser ลบกราฟฟกบนแผนที่ที่ไดสรางไว 
 

4)  การเปด Published Map Documents 
คลิกที่ Open  หรือเลือกที่เมนู File > Open แลวเลือกไฟล Published Map Documents (*.pmf) 

และคลิก Open  

 
 

นอกจากนี้ผูใชสามารถเปดไฟลที่เคยเปดใชงานแลวไดจาก Recent Files  หรือไปที่ 
Windows Explorer เพื่อดับเบิ้ลคลิกที่ไฟล Published Map Documents (*.pmf) เพื่อเปดขอมูลและเขาสูโปรแกรมได
โดยตรง 

5) การใชงาน Table of Contents 
Table of Contents เปนที่สําหรับแสดงรายการขอมูลและสัญลักษณของขอมูล โดยผูใชสามารถใช

งานไดดังนี้ 

5.1)  การเปด/ปด ชั้นขอมูล  
ผูใชสามารถเลือก เปด/ปด ช้ันขอมูลที่ตองการใหแสดงผลใน Data View และ Layout View 

ไดตามความตองการ จาก Table of Contents โดยเลือก  ที่หนาช่ือช้ันขอมูลเพื่อใหแสดงผล หรือเลือก  ที่หนาช่ือ
ช้ันขอมูลเพื่อไมใหแสดงผล ซึ่งประกอบการเลือก เปด/ปด ช้ันขอมูลประกอบไปดวยปายช่ือของขอมูล และชั้น
ขอมูล 



การศึกษาพัฒนาระบบสนับสนุนการจัดการ องคการความรวมมือระหวางประเทศแหงญี่ปุน (ไจกา)  
ทรัพยากรธรรมชาติและสิ่งแวดลอม รวมกับ  บริษัท โคคูไซ โคเกียว จํากัด 
ในระดับจังหวัดของประเทศไทย                                                                      และ เอ็กซ คอรปอเรชัน่  
 

 2-93

5.2)  การดูรายละเอียดของชั้นขอมูลท่ีซอนไว 
ผูใชสามารถดูรายละเอียดของชั้นขอมูลที่ซอนไว และสัญลักษณของชั้นขอมูล โดยคลิกที่  

เพื่อแสดงรายละเอียดของชั้นขอมูล หรือคลิกที่  เพื่อซอนรายละเอียดของชั้นขอมูล 

 
 

5.3)  การดูคุณสมบัติของชั้นขอมูล 
ผูใชสามารถดูคุณสมบัติของชั้นขอมูล ไดแก ขอมูลทั่วไป (General) และที่จัดเก็บขอมูล 

(Source) โดยคลิกขวาที่ช้ันขอมูล และเลือก Properties 
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6) การใชงาน Data View 
Data View เปนหนาตางมุมมองขอมูล สําหรับแสดงแผนที่เพื่อการแสดงผลหนาจอคอมพิวเตอร ซึ่ง

ผูใชสามารถดูแผนที่ตามชั้นขอมูลที่เลือกใน Table of Contents ซึ่งผูใชสามารถใชเครื่องมือตางๆ จาก Navigation 
Toolbars สําหรับทํางานกับแผนที่ และเมื่อนําเมาสไปวางใน Data View คาพิกัดภูมิศาสตรจะถูกแสดงที่แถบสถานะ 

 
 

หากผูใชอยูใน Layout View สามารถกลับมาที่ Data View ไดโดยเลือกที่เมนู View > Data View 
 

 
 

 
7) การใชงาน Layout View 

Layout View เปนหนาตางมุมมองขอมูล สําหรับแสดงแผนที่สําหรับการพิมพ ซึ่งผูใชสามารถดูแผน
ที่ตามช้ันขอมูลที่เลือกใน Table of Contents ซึ่งผูใชสามารถใชเครื่องมือตางๆ ใน Navigation Toolbars สําหรับ
กําหนดมาตราสวนการแสดงผลแผนที่ และบริเวณที่จะแสดงผลแผนที่ใน Layout View สําหรับการแสดงผลแผนที่
สําหรับการพิมพในหนาจอคอมพิวเตอร ผูใชสามารถใชเครื่องมือใน Layout Toolbars สําหรับทํางานกับแผนที่
สําหรับการพิมพ และเมื่อนําเมาสไปวางใน Data View คาพิกัดภูมิศาสตรและคาพิกัดของหนากระดาษจะถูกแสดงที่
แถบสถานะ 

 
 

โดยผูใชสามารถเขาสูหนาตาง Layout View ไดโดยเลือกที่เมนู View > Layout View 
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8) การใชงาน Magnifier Window 
Magnifier Window เปนเครื่องมือที่ชวยใหเห็นรายละเอียดของแผนที่โดยไมตองปรับเปลี่ยนแผนที่

ใน Data View โดยสามารถเรียกใชไดจากเมนู Window > Magnifier 
 

 
 

ในการใชงานผูใชสามารถเลื่อน Magnifier Window ไปยังตําแหนงที่ตองการขยาย และผูใชสามารถ
เลือกขนาดของการขยายไดโดยคลิกขวาที่ Magnifier Window และเลือก Magnifier Factor จากนั้นจึงเลือกขนาดที่
ตองการขยาย 
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9) การเรียกดูขอมูลเชิงบรรยาย 
การเรียกดูขอมูลเชิงบรรยายผูใชสามารถใชเครื่องมือ Identify  ในการเรียกดู โดยในการใชงาน

ใหคลิกที่เครื่องมือ Identify  และคลิกที่ตําแหนงที่ตองการดูขอมูลเชิงบรรยายใน Data View หรือ Layout 
View 

 
 

หรือผูใชสามารถใช Identify ลากกรอบใน Data View หรือ Layout View เพื่อเรียกดูกลุมขอมูลใน
บริเวณที่ตองการได 
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โดยทั่วไปคําสั่ง Identify จะเลือกช้ันขอมูลที่อยูบนสุด ซึ่งในบางครั้งทําใหไมสามารถเลือกช้ันขอมูล
ที่ตองการได ซึ่งผูใชสามารถเลือกเงื่อนไขการ Identify ไดจาก Identify from 

 
 

จากหนาตาง Identify ผูสามารถใชคําสั่งอื่นๆ เพื่อทํางานกับช้ันขอมูลที่เลือกโดยคลิกขวาที่ช้ันขอมูล
ที่ตองการ ซึ่งจะปรากฏคําสั่งตางๆ ใหเลือกใชดังนี้ 
 

 Flash – กระพริบไปยังช้ันขอมูล 
 Zoom To - ขยายไปยังช้ันขอมูล 
 Pan To - เลื่อนไปยังช้ันขอมูล 

Sort Ascending – เรียงลําดับช้ันขอมูลจากนอยไปมาก 
Remove from Tree - ลบช้ันขอมูลออกจากหนาตาง Identify 
Copy Record – คัดลอกขอมูลเชิงบรรยาย 
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นอกจากนั้นในหนาตาง Identify ยังมีการแสดงพิกัดทางภูมิศาสตรของชั้นขอมูลที่เรียกดู แสดงผลที่
ชอง Location ซึ่งผูใชสามารถเปลี่ยนรูปแบบพิกัดทางภูมิศาสตรที่ใชแสดงผลไดโดยคลิกที่ Choose Units  เพื่อ
เปลี่ยนรูปแบบพิกัดทางภูมิศาสตรที่ใชแสดงผล 

 
10.  การคนหาขอมูล 

การคนหาขอมูลผูใชสามารถใชเครื่องมือ Find  ในการคนหา โดยในการใชงานใหคลิกที่
เครื่องมือ Find  และใสเงื่อนไขการคนหาเพื่อคนหาขอมูลตามตองการในหนาตาง Find และคลิกที่ปุม 

 โดยผลการคนหาจะปรากฏอยูในสวนลางของหนาตาง 
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จากหนาตาง Find ในผลการคนหาผูสามารถใชคําสั่งอื่นๆ เพื่อทํางานกับช้ันขอมูลที่คนหาพบ โดย
คลิกขวาที่ช้ันขอมูลที่ตองการ ซึ่งจะปรากฏคําสั่งตางๆ ใหเลือกใชดังนี้ 

 Flash - กระพริบไปยังช้ันขอมูล 
 Zoom To - ขยายไปยังช้ันขอมูล 
 Pan To - เลื่อนไปยังช้ันขอมูล 
 Identify - เรียกดูขอมูลเชิงบรรยายของชั้นขอมูล 
 Add to My Places - สรางตําแหนง My Places 
 Manage My Places - จัดการตําแหนง My Places 

 

 
 

11.  การใชงาน My Place 
My Places เปนการสรางขอมูลเพื่อระบุตําแหนงหรือสถานที่ที่ผูใชตองการกลับมาใชใหมอีกครั้ง

โดยไมตองคนหาอีก โดยจากหนาตาง Find ในผลการคนหา ผูใชสามารถจัดเก็บขอมูลที่คนหาพบไวใน My Places 
โดยเลือกขอมูลที่ตองการจัดเก็บแลวคลิกขวาและเลือก Add to My Places 
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 โดยผูใชสามารถเขาไปจัดการ My Places ไดจากเมนู Tools > My Places 

 
 

12.  การไปยังตําแหนง XY 
การไปยังตําแหนง XY ผูใชสามารถใชเครื่องมือ Go To XY  เพื่อไปยังตําแหนงที่ตองการ โดย

ใสคาพิกัดทางภูมิศาสตรในชอง XY และใชเครื่องมือตางๆ ในการทํางานตามคําสั่ง ไดแก 

 Pan To - เลื่อนไปยังตําแหนงพิกัด 
 Zoom To - ขยายไปยังตําแหนงพิกัด 
 Flash To - กระพริบไปยังตําแหนงพิกัด 
 Mark XY - แสดงจุดพิกัดในแผนที่ 
 Text XY - แสดงคาพิกัดในแผนที่ 
 Label XY - แสดงปายช่ือพิกัดในแผนที่ 
  Undo - เลือกพิกัดที่ผานมา 
 Choose Units - เปลี่ยนรูปแบบการปอนคาพิกัด 
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13.  การวัดระยะ 
การวัดระยะในแผนที่ผูใชสามารถใชเครื่องมือ Measure  ในการวัดระยะตางๆ ซึ่งมีหลายวิธี 

โดยในการใชงานใหคลิกที่เครื่องมือ Measure  จะปรากฏหนาตาง Measure ซึ่งมีเครื่องมือตางๆ ใหเลือก
ใชได ไดแก 

 Measure Line - การวัดระยะความยาว 
 Measure An Area - การวัดขนาดพื้นที่ 
 Measure A Feature - การวัดระยะตําแหนงของขอมูล 
 Snap to Features (on/off) – เปด/ปด การเลื่อนจุดวัดระยะไปยังขอมูล 
 Show Total (on/off) – การเปด/ปด การแสดงผลรวมของการวัดระยะ 
 Choose Units - การเปลี่ยนหนวยสําหรับการวัดระยะ 
  Clear and Reset Results – การลางคาหนาตาง Measure 

 
 โดยในการวัดระยะผูใชสามารถคลิกที่จุดเริ่มตน และคลิกที่จุดถัดไปจนถึงจุดสิ้นสุด เพื่อวัด

ระยะทาง หรือขนาดของพื้นที่ ซึ่งผลการวัดจะถูกแสดงในหนาตาง Measure 
 

 
 

 

14.  การเชื่อมโยงกับขอมูลภายนอก 
ใน Published Map Documents บางชั้นขอมูลที่มีการสรางการเชื่อมโยงกับขอมูลภายนอกไว เชน 

รูปภาพ เอกสาร Website ฯลฯ ซึ่งผูใชสามารถเรียกดูไดโดยเปดช้ันขอมูลที่มีการสรางการเชื่อมโยง ใน Table of 
Contents และคลิกที่เครื่องมือ Hyperlinks  ซึ่งขอมูลที่มีการสรางการสรางการเชื่อมโยง จะปรากฏสัญลักษณ  
ผูใชสามารถคลิกที่ตําแหนงที่ตองการเพื่อเปดดูขอมูลที่เช่ือมโยงไว 
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15.  การปรับรูปแบบการแสดงชั้นขอมูล 
การปรับรูปแบบการแสดงผลชั้นขอมูลสามารถทําได 2 วิธีจากเครื่องมือ Layer Effects Toolbars คือ 

15.1)  ปรับการโปรงแสงของชั้นขอมูล (Layer List) 
โดยในการใชใหผูใชเลือกช้ันขอมูลที่ตองการจากเครื่องมือ Layer List ของ เครื่องมือ Layer 

Effects Toolbars และคลิกที่เครื่องมือ Transparency  เพื่อปรับคาความโปรงแสง โดยใชกดเมาสคางไวที่แถบ 
Transparency และเลื่อนแถบขึ้นเพื่อเพิ่มคาความโปรงแสง และเลื่อนลงเพื่อลดคาการโปรงแสง 
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15.2)  การทํางานกับชั้นขอมูลท่ีถูกปดบัง (Swipe Layer) 
โดยในการใชใหผูใชเลือกช้ันขอมูลที่ตองการจากเครื่องมือ Layer List ของ เครื่องมือ Layer 

Effects Toolbars และคลิกที่เครื่องมือ Swipe Layer  เพื่อเลื่อนช้ันขอมูลที่เลือกไมใหบังช้ันขอมูลอื่นๆ โดยใช
กดเมาสคางไวแลวเลื่อนขึ้นลง หรือซายขวา เพื่อเลื่อนช้ันขอมูล 

 
 
 

16.  การวาดกราฟฟกในแผนที่ 
ผูใชสามารถวาดกราฟฟกเพื่อเนนขอมูลที่สนใจในแผนที่ เพื่อนําภาพแผนที่ดังกลาวไปใชงานตอ 

เชน การประกอบรายงาน หรือการนําเสนอขอมูล โดยการวาดเครื่องหมายในแผนที่สามารถใชเครื่องมือ Markup 
Toolbars สําหรับทําเครื่องหมาย ซึ่งประกอบไปดวยเครื่องมือตางๆ ดังนี้ 

 Pen - สําหรับวาดเสนกราฟฟกบนแผนที่ 
 Higthlighter - สําหรับสรางกราฟฟกบนแผนที่เพื่อเนนขอมูล 
 Eraser - ลบกราฟฟกบนแผนที่ที่ไดสรางไว 

หลังจากใชเครื่องมือ Markup Toolbars ไฟล pmfink จะถูกสรางขึ้นมาซึ่งเปนไฟลสําหรับจัดเก็บ
กราฟฟกที่สรางไว และชื่อเดียวกับ Published Map Documents เมื่อเปด Published Map Documents ในครั้งตอไป
โปรแกรมจะมีหนาตางเพื่อถามวาจะใช Markup ที่สรางไวกับ Published Map Documents หรือไม ซึ่งผูใชสามารถ
เลือกได 
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17.  การสงออกขอมูลแผนที่ 
ผูใชสามารถสงออกขอมูลแผนที่ออกไปเปนขอมูลรูปภาพแบบ Bitmap Files (*.bmp) เพื่อนําไปใช

ในการประกอบรายงาน หรือการนําเสนอโดยเลือกที่เมนู File > Export Map แลวเลือกที่จัดเก็บไฟล และตั้งช่ือไฟล 
จากนั้นจึงคลิก  เพื่อบันทึกขอมูล 

 
 

โดยในการสงออกขอมูลแผนที่ หากผูใชอยูในหนาตาง Data View ขอมูลรูปภาพจะถูกสงออก
เฉพาะบริเวณที่แสดงผลใน Data View เทานั้น และถาผูใชอยูในหนาตาง Layout View ขอมูลรูปจะถูกสงออก
ครอบคลุมทั้งแผนที่  
 

18.  การพิมพแผนที่ 
ผูใชสามารถพิมพแผนที่ออกทางเครื่องพิมพได โดยสามารถตั้งคาหนากระดาษไดจากเมนู File > 

Page Setup เพื่อกําหนดขนาดและรูปแบบของกระดาษ เมื่อเรียบรอยแลวคลิกที่  
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และสั่งพิมพออกทางเครื่องพิมพไดจากเมนู File > Print โดยผูใชสามารถเลือกเครื่องพิมพ และ
กําหนดคุณสมบัติของการพิมพ และสั่งพิมพโดยคลิกที่  
 

 
 

โดยในการพิมพแผนที่ออกทางเครื่องพิมพ หากผูใชอยูในหนาตาง Data View จะเปนการพิมพ
เฉพาะบริเวณที่แสดงผลใน Data View เทานั้น และถาผูใชอยูในหนาตาง Layout View การพิมพจะครอบคลุมทั้ง
แผนที่ 
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